Click the links on the left for information on the features, options, and operation of your printer. For information on other documentation included with your printer, see "Finding Information".

**Front View**

<table>
<thead>
<tr>
<th>1</th>
<th>Operator panel</th>
<th>5</th>
<th>Belt unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Front cover</td>
<td>6</td>
<td>Side cover (toner cartridges inside)</td>
</tr>
<tr>
<td><strong>NOTE:</strong> You can open the front cover by pushing the button (right side)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Single sheet feeder</td>
<td>7</td>
<td>Button (right side)</td>
</tr>
<tr>
<td>4</td>
<td>Tray 1</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Rear View**

<table>
<thead>
<tr>
<th>1</th>
<th>Network cover</th>
<th>3</th>
<th>Power switch</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Reset button</td>
<td>4</td>
<td>USB port</td>
</tr>
</tbody>
</table>

**NOTE:** You can use your network as standard, if your printer is type B as shown in the illustration.
To order replacement toner cartridges or supplies from Dell:

1. Double-click the icon on your desktop.

2. Visit the Dell Printer Supplies website at www.dell.com/supplies, or order Dell printer supplies by phone.
   For best service, have your Dell printer Service Tag available.
   For help locating your Service Tag number, see "Express Service Code and Service Tag number."
## Finding Information

**NOTE:** The following are options you need to buy separately.

- USB cable
- Ethernet cable

<table>
<thead>
<tr>
<th>What are you looking for?</th>
<th>Find it here</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drivers for my printer</td>
<td>Drivers and Utilities CD</td>
</tr>
<tr>
<td>My User's Guide</td>
<td>The Drivers and Utilities CD contains documentation and drivers for your printer. You can use the CD to uninstall/reinstall drivers or access your documentation. Readme files may be included on your CD to provide last-minute updates about technical changes to your printer or advanced technical reference material for experienced users or technicians.</td>
</tr>
<tr>
<td>Safety information</td>
<td>Owner's Manual</td>
</tr>
<tr>
<td>How to use my printer</td>
<td>NOTE: The Owner’s Manual may not be available in your country or region.</td>
</tr>
<tr>
<td>Warranty information</td>
<td>Product Information Guide</td>
</tr>
<tr>
<td></td>
<td><strong>CAUTION:</strong> Read and follow all safety instructions in your Product Information Guide prior to setting up and operating your printer.</td>
</tr>
<tr>
<td>How to set up my printer</td>
<td>Setup diagram</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Troubleshooting</td>
<td>Troubleshooting Guide</td>
</tr>
<tr>
<td>Express Service Code and</td>
<td>The Express Service Code and Service Tag numbers are located inside the side door of your printer.</td>
</tr>
<tr>
<td>Service Tag number</td>
<td></td>
</tr>
<tr>
<td>Latest drivers for my printer</td>
<td>See the Dell Support website at support.dell.com</td>
</tr>
</tbody>
</table>
The Dell Support website, support.dell.com, provides several online tools, including:

- **Solutions** - Troubleshooting hints and tips, articles from technicians, and online courses
- **Upgrades** - Upgrade information for components, such as printer driver
- **Customer Care** - Contact information, order status, warranty, and repair information
- **Downloads** - Drivers
- **Reference** - Printer documentation and product specifications

You can access the Dell Support website at support.dell.com. Select your region on the support page, and fill in the requested details to access help tools and information.
About Your Printer

- Operator Panel
- Protecting Your Printer

The following illustrations show the standard Dell™ Color Laser Printer 1320c.

1. Operator panel
2. Front cover
3. Single sheet feeder
4. Tray 1
5. Belt unit
6. Button (right side)

Provide enough room to open the printer tray, covers, and option. It is also important to allow space around the printer for proper ventilation.

Operator Panel
For details on the operator panel, see "Operator Panel."

## Protecting Your Printer

To protect your printer from theft, you can use the optional Kensington lock.

Attach the Kensington lock to the security slot of your printer.

For details, see the operating instructions supplied with the Kensington lock.
Installing the Toner Cartridges and PHD (Print Head Device) Unit

Installing the Toner Cartridges

1. Open the side cover.

2. Completely pull out and remove the four ribbons.

3. Press and slide the blue latches of four toner cartridges to the locked position.

4. Close the side cover.

CAUTION: Before performing any of the following procedures, read and follow the safety instructions in your Product Information Guide.

NOTICE: To protect the drums of the toner cartridges against bright light, close the front cover within three minutes. If the front cover remains open for more than three minutes, print quality may deteriorate.

NOTICE: Ensure that nothing touches or scratches the surface (black-colored film) of the belt unit. Scratches, dirt, or oil from your hands on the film of the belt unit may affect print quality.
Installing the PHD (Print Head Device) Unit

1. Press the button (right side) and open the front cover.

2. Turn the four PHD lock levers counterclockwise to unlock the unit.

3. Pull the PHD unit out of the printer.

   🔄 **NOTICE:** Do not touch the belt unit.

   🔄 **NOTICE:** Do not remove the protective sheet on the PHD unit.

4. Completely remove the four yellow ribbons from the PHD unit.
5. Use the small gray tabs to place the PHD unit back into the printer completely.

6. Turn the four PHD lock levers clockwise to lock the PHD, and then remove the protective sheet.

7. Close the front cover.
Connecting Your Printer

- Choosing the Right Cable
- Connecting the Printer Directly to a Computer
- Turn On the Printer
- Connecting the Printer to a Network
- Using the Reset button

Choosing the Right Cable

Your Dell™ Color Laser Printer 1320c interconnection cable must meet the following requirements:

<table>
<thead>
<tr>
<th>Connection type</th>
<th>Connection specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>USB</td>
<td>USB 2.0</td>
</tr>
<tr>
<td>Ethernet*</td>
<td>10 Base-T/100 Base-TX</td>
</tr>
</tbody>
</table>

* If your printer is type A, an optional Network Adapter for Dell 1320c is required to connect the Ethernet cable.

NOTE: You can use your network as standard, if your printer is type B as shown in the illustration.

Connecting the Printer Directly to a Computer

A local printer is a printer attached to your computer using a USB cable. If your printer is attached to a network instead of your computer, skip this section and go to "Turn On the Printer."

To attach the printer to a computer:

1. Ensure that the printer, computer, and any other attached devices are turned off and unplugged.
2. Connect the printer to the computer using a USB.

A USB port requires a USB cable. Ensure that you match the USB symbol on the cable to the USB symbol on the printer.

Plug the other end of the cable into a USB port on the back of the computer. For a USB cable, do not plug it into the USB keyboard.

**Turn On the Printer**

1. Connect the power cable to the printer and plug it into an electrical wall outlet.

   \[\textbf{CAUTION:}\] Do not use extension cords or power strips.

   \[\textbf{CAUTION:}\] The printer should not be plugged into a UPS system.

2. Turn on the computer and the printer. When you use the USB cable, the USB driver is automatically installed.

**Connecting the Printer to a Network**
To attach the printer to a network:

1. Ensure that the printer, computer, and any other attached devices are turned off and unplugged.
2. Remove the network cover.

3. Insert the Network Adapter for Dell 1320c.

4. Connect the printer to the network using an Ethernet cable.

To connect the printer to the network, plug one end of an Ethernet cable into the Ethernet port on the back of the printer, and the other end into a LAN drop or hub.
**Turn On the Printer**

1. Plug one end of the printer power cable into the socket at the back of the printer and the other end into a properly grounded outlet.

2. Turn on the computer and the printer.

**CAUTION:** Do not use extension cords or power strips.

**CAUTION:** The printer should not be plugged into a UPS system.

**NOTE:** If your printer is type A, the LED of the Network Adapter for Dell 1320c lights.

**Print and Check the Printer Settings Page**

Print the Printer Settings page.

When the Ready/Data indicator lights (ready status), press and hold the Continue button on the printer’s operator panel until the Ready/Data indicator blinks.

**Advanced Functions**

**NOTE:** The following sections are considered advanced functions and should only be carried out by a system administrator. These sections assume you have already installed the Dell Color Laser Software on your PC.

1. Click Start → All Programs → Dell Printers → Additional Color Laser Software → Status Monitor Console.
   
   The Printer Selection dialog box opens.

2. Click Dell Color Laser 1320c listed in Printer Name.
   
   The Dell Color Laser 1320c Launcher window opens.

3. Click the Tool Box button.
   The Tool Box opens.
   You can also launch the Tool Box from the printer icon on the taskbar.

4. Click the Printer Settings Report tab.

5. Select Reports from the list at the left side of the page.
   The Reports page is displayed.

**Assign an IP Address**

An IP address is a unique number that consists of four sections that are delimited by a period and can include up to three digits in each section, for example, 111.222.33.44.

Assigning an IP address already in use can cause network performance issues.

**NOTE:** Assigning an IP address is considered as an advanced function and is normally done by a system administrator.

1. Click Start → All Programs → Dell Printers → Additional Color Laser Software → Status Monitor Console.
   
   The Printer Selection dialog box opens.

2. Click Dell Color Laser 1320c listed in Printer Name.
   
   The Dell Color Laser 1320c Launcher window opens.

3. Click the Tool Box button.
   The Tool Box opens.
   You can also launch the Tool Box from the printer icon on the taskbar.

4. Click the Printer Maintenance tab.
5. Select TCP/IP Settings from the list at the left side of the page. The TCP/IP Settings page is displayed.

6. Select the mode from IP Address Mode, and then enter the values in IP Address, Subnet Mask, and Gateway Address.

7. Press the Apply New Settings button to take effect.

You can also assign the IP address to the printer when installing the printer drivers with installer. When you use the Network Installation feature, you can set the IP address from 0.0.0.0 to the desired IP address on the printer selection window.

### Verify the IP Settings

1. Print another Printer Settings page.

2. Look under the TCP/IP heading on the Printer Settings page to ensure that the IP address, netmask, and gateway are what you expected.

   or

   Ping the printer and verify that it responds. For example, at a command prompt on a network computer, type ping followed by the new printer IP address (for example, 192.168.0.11):

   ```
   ping 192.168.0.11
   ```

   If the printer is active on the network, you will receive a reply.

### Using the Reset button

Your printer is supplied with an electric leakage detector, which prevents electric shock or fire due to electric leakage by automatically cutting circuits inside the printer.

When electric leakage is detected, the Reset button is tripped. In this case, press the Reset button to turn the printer back on. If the Reset button is tripped again after you press the Reset button, contact Dell.

Check whether or not the electric leakage detector is functioning at least once a month by following the steps below:

1. Turn on the printer, and then press the Test button.

   - If the Reset button is tripped and the printer is turned off, the electric leakage detector functions correctly. Press the Reset button to turn the printer back on.
   - If the Reset button is not tripped, contact Dell. Do not continue to use the printer if the electric leakage detector is not functioning.
Dell Printer Configuration Web Tool

Using the Dell Printer Configuration Web Tool

**NOTE:** This web tool is not available unless the printer is connected using a network cable.

One of the features of the Dell™ Printer Configuration Web Tool is E-Mail Alert Setup, which sends an e-mail to you or the key operator when the printer needs supplies or intervention.

To fill out printer inventory reports requiring the asset tag number of all the printers in your area, use the Printer Information feature in the Dell Printer Configuration Web Tool. Just type the IP address of each printer on the network to display the asset tag number.

The Dell Printer Configuration Web Tool feature also allows you to change the printer settings and keep track of printing trends. If you are a network administrator, you can easily copy the printer settings to one or all printers on the network using your Web browser.

To launch the Dell Printer Configuration Web Tool, type your network printer’s IP address in your Web browser.

If you do not know the IP address of your printer, print a printer settings page, which lists the IP address:

1. Click **Start**→**All Programs**→**Dell Printers**→**Additional Color Laser Software**→**Status Monitor Console**. The Printer Selection dialog box opens.
2. Click Dell Color Laser 1320c listed in Printer Name. 
The Dell Color Laser 1320c Launcher window opens.

3. Click the Tool Box button. 
The Tool Box opens. 
You can also launch the Tool Box from the printer icon on the taskbar.

4. Click the Printer Maintenance tab.

5. Select EWS (Embedded Web Server or Dell Printer Configuration Web Tool) from the list on the left side of the page. 
The EWS page is displayed.

6. Press the Print Server Settings button. 
The printer settings page is printed.

If the IP address shows 0.0.0.0 (the factory default), an IP address has not been assigned. To assign one for your printer, see "Assign an IP Address."

Use the Dell Printer Configuration Web Tool for:

**Printer Status**

Use the Printer Status menu to get immediate feedback on printer supply status. When toner cartridge is running low, click the order supplies link on the first screen to order additional toner cartridges.

**Printer Jobs**

Use the Printer Jobs menu to contain information on Job List page and Completed Jobs page. These pages show the details of the status regarding each protocol or the print jobs.

**Printer Settings**

Use the Printer Settings menu to change printer settings and view the settings in the Tool Box remotely.

**Print Server Settings**

Using the Print Server Settings menu, you can change the type of printer interface and necessary conditions for communications.

**Copy Printer Settings**

Use the Copy Printer Settings menu to copy the printer’s settings to another printer or printers on the network just by typing each printer's IP address.

*NOTE:* You must log in as an administrator to use this feature.

**Print Volume**

Use the Print Volume option to check the histories of printing, such as paper usage and types of jobs being printed, and limit which users use the color mode and the maximum number of pages they can print.

**Printer Information**

Use the Printer Information menu to get the information on service calls, inventory reports, or the status of current memory and engine code levels.

**E-Mail Alert**

Use the E-Mail Alert menu to receive an e-mail when the printer needs supplies or intervention. Type your name or the key operator's name in the e-mail list box to be notified.

**Set Password**

*NOTE:* You must log in as an administrator to use this feature.
Use the **Set Password** menu to lock the Dell Printer Configuration Web Tool with a password so that other users do not inadvertently change the printer settings you selected.

**NOTE:** You must log in as an administrator to use this feature.

### Online Help

Click **Online Help** to visit the Dell Support website, and see the *User's Guide* on that page to verify configured settings.

**Order Supplies at:**

[www.dell.com/supplies](http://www.dell.com/supplies)

**Contact Dell Support at:**

[support.dell.com](http://support.dell.com)

### Using the Dell Printer Configuration Web Tool

Ensure that you activate JavaScript in your browser before using the Dell Printer Configuration Web Tool.

**Environment Settings for Web Browsers**

Dell recommends configuring the environment settings for your Web browsers, before using the Dell Printer Configuration Web Tool.

**NOTE:** The Dell Printer Configuration Web Tool pages may be displayed unreadable if the pages were configured by the different language with your browser's.

#### For Internet Explorer® 6.0 or Internet Explorer 7.0:

**Setting Up the Display Language**

1. Select **Internet Options** from the **Tools** menu.
2. Select **Languages** in the **General** tab.
3. Specify the display language in order of preference in the **Language in order of preference** list.

   For example:
   - Italian (Italy) [it]
   - Spanish (Traditional Sort) [es]
   - German (Germany) [de]
   - French (France) [fr]
   - English [en] or English (United States) [en-us]

**Setting the Printer's IP Address to Non-Proxy**

1. Select **Internet Options** from the **Tools** menu.
2. Select **Proxy server** under **LAN Settings** in the **Connections** tab.
3. Do either of the following:
   - Clear the **Use a proxy server for your LAN** check box.
   - Click **Advanced**, and then specify the printer's IP address in the **Do not use proxy server for addresses beginning with** field under **Exceptions**.

After setting the language and proxy, type `<http://nnn.nnn.nnn.nnn/>` (the printer's IP address) in the URL entry field of the browser to activate the Dell Printer Configuration Web Tool.

**For Firefox 1.5 or Later:**

**Setting Up the Display Language**

1. Select **Options** from the **Tools** menu.
2. Click **Advanced**.
3. Click **Edit Languages** in the **General** tab.

4. Specify the display language in order of preference in the **Languages in order of preference** list.

   For example:
   - English [en] or English/United States [en-us]
   - Italian [it]
   - Spanish [es]
   - German [de]
   - French [fr]
   - Dutch [nl]
   - Norwegian [no]
   - Swedish [sv]

### Setting the Printer's IP Address to Non-Proxy

1. Select **Options** from the **Tools** menu.
2. Click **General** on the **Options** dialog box.
3. Click **Connection Settings** 
4. Do one of the following:
   - Select the **Direct connection to the Internet** check box.
   - Select the **Auto-detect proxy settings for this network** check box.
   - Select the **Manual proxy configuration** check box, and then enter the printer's IP address in the **No Proxy for** edit box.
   - Select the **Automatic proxy configuration URL** check box.

After setting the language and proxy, type `<http://nnn.nnn.nnn.nnn/>` (the printer's IP address) in the URL entry field of the browser to activate the **Dell Printer Configuration Web Tool**.

### Page Display Format

The layout of the page is divided into three sections mentioned below:

#### Top Frame

The Top Frame is located at the top of all pages. When **Dell Printer Configuration Web Tool** is activated, the current status and specifications of the printer are displayed in the Top Frame on every page.

The following items are displayed in the Top Frame.

<table>
<thead>
<tr>
<th>Dell Color Laser 1320c</th>
<th>Displays the printer product name.</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP Address</td>
<td>Displays the printer's IP address.</td>
</tr>
<tr>
<td>Location</td>
<td>Displays the printer's location. The location can be changed in <strong>Basic Information</strong> on the <strong>Print Server Settings</strong> page.</td>
</tr>
<tr>
<td>Contact Person</td>
<td>Displays the printer's administrator's name. The name can be changed in the <strong>Basic Information</strong> on the <strong>Print Server Settings</strong> page.</td>
</tr>
<tr>
<td>Printer Console</td>
<td>Displays the status of the printer settings and indicators and automatically refreshes at the set interval. The interval can be changed in the <strong>Basic Information</strong> on <strong>Print Server Settings</strong> page.</td>
</tr>
<tr>
<td>Help</td>
<td>Links to the Dell web page. See the User's Guide on the Dell Support website, support.dell.com for help on this product.</td>
</tr>
<tr>
<td>Printer Bitmap</td>
<td>Shows the printer bitmap. The <strong>Printer Status</strong> menu appears in the Right Frame by clicking the bitmap.</td>
</tr>
</tbody>
</table>

#### Left Frame

The Left Frame is located at the left side of all pages. The menu titles displayed in the Left Frame are linked to corresponding menus and pages. You can go to the corresponding page by clicking their characters.

The following menus are displayed in the Left Frame.

| Printer Status | Links to the **Printer Status** menu. |
The Right Frame is located at the right side of all pages. The contents of the Right Frame correspond to the menu that you select in the Left Frame. For details on the items displayed in the Right Frame, see "Details of Menu Items."

### Buttons on the Right Frame

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Refresh Button</td>
<td>Receives the current printer configuration and updates the latest information in the Right Frame.</td>
</tr>
<tr>
<td>Apply New Settings Button</td>
<td>Submits new settings made on the Dell Printer Configuration Web Tool to the printer. The old printer settings will be replaced by the new settings.</td>
</tr>
<tr>
<td>Restart printer to apply new settings Button</td>
<td>Submits new settings made on the Dell Printer Configuration Web Tool to the printer and reboots the printer. The old printer settings will be replaced by the new settings.</td>
</tr>
<tr>
<td>Restore Settings Button</td>
<td>Restores the old settings from before changes made. New settings will not be submitted to the printer.</td>
</tr>
</tbody>
</table>

### Changing the Settings of Menu Items

Some menus allow you to change the printer settings through the Dell Printer Configuration Web Tool. When you are accessing these menus, the authentication dialog appears on the screen. Type a user name and password for the printer's administrator by following the prompts displayed in the dialog box.

The default user name is `admin`, and the default password is left blank (NULL). You can change only the password in the Set Password page in the Print Server Settings menu. The user name cannot be changed. See "Set Password" for more information.

### Details of Menu Items

- **Printer Status**
  - Printer Status
  - Printer Events
  - Printer Information

- **Printer Jobs**
  - Job List
  - Completed Jobs

- **Printer Settings**
  - Printer Settings Report
  - Menu Settings
  - Reports
  - System Settings
  - Paper Density
  - Adjust BTR (Bias Transfer Roll)
  - Adjust Fuser
  - Auto Registration Adjustment
  - Color Registration Adjustments
Use the Printer Status menu to check the status of consumables, hardware, and specifications of the printer.

The following pages are displayed in the Printer Status menu.

**Printer Status**

**Purpose:**

To check the status of remaining consumables and trays.

**Values:**

<table>
<thead>
<tr>
<th>Cyan Cartridge Level</th>
<th>Displays the percentage of toner remaining in each toner cartridge. When a cartridge is empty, a message appears. The text Print Cartridge is linked to the Dell Printer Supplies website, <a href="http://www.dell.com/supplies">www.dell.com/supplies</a>.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Magenta Cartridge Level</td>
<td></td>
</tr>
<tr>
<td>Yellow Cartridge Level</td>
<td></td>
</tr>
<tr>
<td>Black Cartridge Level</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Paper Trays Status</th>
<th>OK Indicates that there is some paper in the tray but the quantity is unknown.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Add Paper Indicates that there is no paper in the tray.</td>
</tr>
<tr>
<td></td>
<td>Capacity Displays the maximum capacity of the paper tray.</td>
</tr>
<tr>
<td></td>
<td>Size Not available for this printer.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Output Tray Status</th>
<th>OK Indicates that the tray is available.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Capacity Displays the maximum capacity of the paper tray.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Cover Status</th>
<th>Closed Indicates that the cover is closed.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Open Indicates that the cover is open.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Printer Type</th>
<th>Displays the type of printing for the printer. Color Laser is displayed normally.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Printing Speed</th>
<th>Displays the printing speed for the printer.</th>
</tr>
</thead>
</table>

**Printer Events**
Purpose:

When printer errors occur such as running out of paper or running out of toner cartridge, the details of all alerts or indications of errors are displayed in the Printer Events page.

Values:

<table>
<thead>
<tr>
<th>Location</th>
<th>Displays the location where the printer error occurred.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Details</td>
<td>Displays the details of the printer fault.</td>
</tr>
</tbody>
</table>

Printer Information

Purpose:

To verify the printer details such as hardware configuration and software version. This page can also be displayed by clicking Printer Information in the Left Frame.

Values:

<table>
<thead>
<tr>
<th>Dell Service Tag Number</th>
<th>Displays Dell’s service tag number.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asset Tag Number</td>
<td>Displays the printer’s asset tag number.</td>
</tr>
<tr>
<td>Printer Serial Number</td>
<td>Displays the printer’s serial number.</td>
</tr>
<tr>
<td>Memory Capacity</td>
<td>Displays the memory capacity.</td>
</tr>
<tr>
<td>Processor Speed</td>
<td>Displays the processing speed.</td>
</tr>
<tr>
<td>Printer Revision Levels</td>
<td>Displays the revision date (revision level).</td>
</tr>
<tr>
<td>Network Firmware Version</td>
<td>Displays the revision date (revision level).</td>
</tr>
</tbody>
</table>

Printer Jobs

The Printer Jobs menu contains information on the Job List and Completed Jobs pages. These pages show the details of the status regarding each protocol or the print jobs.

Job List

Purpose:

To confirm the print jobs that are being processed. Click Refresh to update the screen.

Values:

<table>
<thead>
<tr>
<th>ID</th>
<th>Displays the job id.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Job Name</td>
<td>Displays the file name of the job being printed.</td>
</tr>
<tr>
<td>Owner</td>
<td>Displays the job owner’s name.</td>
</tr>
<tr>
<td>Host Name</td>
<td>Displays the name of the host computer.</td>
</tr>
<tr>
<td>Job Status</td>
<td>Displays the status of the job being printed.</td>
</tr>
<tr>
<td>Host I/F</td>
<td>Displays the status of the host interface.</td>
</tr>
<tr>
<td>Job Submitted Time</td>
<td>Displays the date the print job was submitted.</td>
</tr>
</tbody>
</table>
Completed Jobs

Purpose:

To check the completed print jobs. Up to the last 22 print jobs are displayed. Click Refresh to update the screen.

Values:

<table>
<thead>
<tr>
<th>ID</th>
<th>Displays the job ID.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Job Name</td>
<td>Displays the file name of the completed print job.</td>
</tr>
<tr>
<td>Owner</td>
<td>Displays the job owner's name.</td>
</tr>
<tr>
<td>Host Name</td>
<td>Displays the name of the host computer.</td>
</tr>
<tr>
<td>Output Result</td>
<td>Displays the status of completed print jobs.</td>
</tr>
<tr>
<td>Impression Number</td>
<td>Displays the number of pages in the print job.</td>
</tr>
<tr>
<td>No. of Sheets</td>
<td>Displays the number of sheets in the print job.</td>
</tr>
<tr>
<td>Host I/F</td>
<td>Displays the status of the host interface.</td>
</tr>
<tr>
<td>Job Submitted Time</td>
<td>Displays the date the print job was submitted.</td>
</tr>
</tbody>
</table>

Printer Settings

Use the Printer Settings menu to display the printer settings report and to configure printer settings.

The following tabbed pages are displayed at the top of the Right Frame.

Printer Settings Report

The Printer Settings Report tab includes the Menu Settings and Reports pages.

Menu Settings

Purpose:

To display the current settings of the printer.

Values:

<table>
<thead>
<tr>
<th>System Settings</th>
<th>Power Saver Timer Mode 1</th>
<th>Displays the amount of time before the printer enters the power saver timer mode 1 after it finishes a print job.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power Saver Timer Mode 2</td>
<td>Displays the amount of time before the printer enters the power saver timer mode 2 after it finishes a print job.</td>
<td></td>
</tr>
<tr>
<td>Control Panel Tone</td>
<td>Displays whether the printer sounds the tone for the panel.</td>
<td></td>
</tr>
<tr>
<td>Machine Ready Tone</td>
<td>Displays whether the printer sounds the tone when the machine becomes ready.</td>
<td></td>
</tr>
<tr>
<td>Job Complete Tone</td>
<td>Displays whether the printer sounds the tone when a job is completed.</td>
<td></td>
</tr>
<tr>
<td>Fault Tone</td>
<td>Displays whether the printer sounds the tone when an error occurs.</td>
<td></td>
</tr>
<tr>
<td>Alert Tone</td>
<td>Displays whether the printer sounds an alarm when an error occurs.</td>
<td></td>
</tr>
<tr>
<td>Out of Paper Alert Tone</td>
<td>Displays whether the printer sounds the tone when the paper runs out.</td>
<td></td>
</tr>
</tbody>
</table>
### Purpose:

To print various types of reports and lists.

### Values:

#### Report Types

- **Low Toner Alert Tone**
  - Displays whether the printer sounds the tone when the toner is low.

- **Time-Out**
  - Displays the amount of time the printer waits to receive additional bytes of data from the computer.

- **Device Language**
  - Displays the language to be used for E-mail Alert.

- **Auto Log Print**
  - Displays whether the printer outputs logs automatically.

#### Paper Density

<table>
<thead>
<tr>
<th>Type</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain</td>
<td>Light</td>
<td>Displays the paper density in Light for the plain paper.</td>
</tr>
<tr>
<td>Plain</td>
<td>Normal*</td>
<td>Displays the paper density in Normal for the plain paper.</td>
</tr>
<tr>
<td>Label</td>
<td>Light</td>
<td>Displays the paper density in Light for the label.</td>
</tr>
<tr>
<td>Label</td>
<td>Normal*</td>
<td>Displays the paper density in Normal for the label.</td>
</tr>
</tbody>
</table>

#### Adjust BTR

<table>
<thead>
<tr>
<th>Type</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain</td>
<td>Displays the voltage settings of the transfer roller (-6-6) for plain paper. The default is 0.</td>
<td></td>
</tr>
<tr>
<td>Plain Thick</td>
<td>Displays the voltage settings of the transfer roller (-6-6) for thick plain paper. The default is 0.</td>
<td></td>
</tr>
<tr>
<td>Covers</td>
<td>Displays the voltage settings of the transfer roller (-6-6) for cover paper. The default is 0.</td>
<td></td>
</tr>
<tr>
<td>Covers Thick</td>
<td>Displays the voltage settings of the transfer roller (-6-6) for thick cover paper. The default is 0.</td>
<td></td>
</tr>
<tr>
<td>Label</td>
<td>Displays the voltage settings of the transfer roller (-6-6) for labels. The default is 0.</td>
<td></td>
</tr>
<tr>
<td>Coated</td>
<td>Displays the voltage settings of the transfer roller (-6-6) for coated paper. The default is 0.</td>
<td></td>
</tr>
<tr>
<td>Coated Thick</td>
<td>Displays the voltage settings of the transfer roller (-6-6) for thick coated paper. The default is 0.</td>
<td></td>
</tr>
<tr>
<td>Envelope</td>
<td>Displays the voltage settings of the transfer roller (-6-6) for envelopes. The default is 0.</td>
<td></td>
</tr>
<tr>
<td>Recycled</td>
<td>Displays the voltage settings of the transfer roller (-6-6) for recycled paper. The default is 0.</td>
<td></td>
</tr>
<tr>
<td>Coated JPN</td>
<td>Displays the voltage settings of the transfer roller (-6-6) for Japanese coated paper. The default is 0.</td>
<td></td>
</tr>
<tr>
<td>Postcard JPN</td>
<td>Displays the voltage settings of the transfer roller (-6-6) for Japanese postcards. The default is 0.</td>
<td></td>
</tr>
</tbody>
</table>

#### Adjust Fuser

<table>
<thead>
<tr>
<th>Type</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain</td>
<td>Displays the temperature settings of the fuser (-2-2) for plain paper. The default is 0.</td>
<td></td>
</tr>
<tr>
<td>Plain Thick</td>
<td>Displays the temperature settings of the fuser (-2-2) for thick plain paper. The default is 0.</td>
<td></td>
</tr>
<tr>
<td>Covers</td>
<td>Displays the temperature settings of the fuser (-2-2) for cover paper. The default is 0.</td>
<td></td>
</tr>
<tr>
<td>Covers Thick</td>
<td>Displays the temperature settings of the fuser (-2-2) for thick cover paper. The default is 0.</td>
<td></td>
</tr>
<tr>
<td>Label</td>
<td>Displays the temperature settings of the fuser (-2-2) for labels. The default is 0.</td>
<td></td>
</tr>
<tr>
<td>Coated</td>
<td>Displays the temperature settings of the fuser (-2-2) for coated paper. The default is 0.</td>
<td></td>
</tr>
<tr>
<td>Coated Thick</td>
<td>Displays the temperature settings of the fuser (-2-2) for thick coated paper. The default is 0.</td>
<td></td>
</tr>
<tr>
<td>Envelope</td>
<td>Displays the temperature settings of the fuser (-2-2) for envelopes. The default is 0.</td>
<td></td>
</tr>
<tr>
<td>Recycled</td>
<td>Displays the temperature settings of the fuser (-2-2) for recycled paper. The default is 0.</td>
<td></td>
</tr>
<tr>
<td>Coated JPN</td>
<td>Displays the temperature settings of the fuser (-2-2) for Japanese coated paper. The default is 0.</td>
<td></td>
</tr>
<tr>
<td>Postcard JPN</td>
<td>Displays the temperature settings of the fuser (-2-2) for Japanese postcards. The default is 0.</td>
<td></td>
</tr>
</tbody>
</table>

#### Auto Registration Adjustment

<table>
<thead>
<tr>
<th>Type</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto Registration Adjustment</td>
<td>Displays whether to adjust the registration automatically.</td>
<td></td>
</tr>
</tbody>
</table>

#### Adjust Altitude

<table>
<thead>
<tr>
<th>Type</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adjust Altitude</td>
<td>Displays whether to adjust the height of the installation location of the printer.</td>
<td></td>
</tr>
</tbody>
</table>

#### Non-Dell Toner

<table>
<thead>
<tr>
<th>Type</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Non-Dell Toner</td>
<td>Displays whether to use a refilled toner cartridge.</td>
<td></td>
</tr>
</tbody>
</table>

#### Web Link Customization

<table>
<thead>
<tr>
<th>Type</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
</table>
| Web Link Customization | Select Reorder URL | Regular*
  - Displays the URL (accessories.us.dell.com/sna) that can be linked from Order Supplies at in the left frame. |
| Web Link Customization | Select Reorder URL | Premier
  - Displays the URL (premier.dell.com) that can be linked from Order Supplies at in the left frame. |

---

**Printer Settings**

- **Click the Start button to print the printer settings page.**

**Device Settings**

- **Click the Start button to print the device settings page.**
Printer Settings

The Printer Settings tab includes System Settings page.

System Settings

Purpose:

To configure the basic printer settings.

Values:

<table>
<thead>
<tr>
<th>Power Saver Timer Mode 1</th>
<th>Displays the amount of time before the printer enters the power saver timer mode 1 after it finishes a print job.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power Saver Timer Mode 2</td>
<td>Displays the amount of time before the printer enters the power saver timer mode 2 after it finishes a print job.</td>
</tr>
<tr>
<td>Control Panel Tone</td>
<td>Displays whether the printer sounds the tone for the panel.</td>
</tr>
<tr>
<td>Machine Ready Tone</td>
<td>Displays whether the printer sounds the tone when the machine becomes ready.</td>
</tr>
<tr>
<td>Job Complete Tone</td>
<td>Displays whether the printer sounds the tone when a job is completed.</td>
</tr>
<tr>
<td>Fault Tone</td>
<td>Displays whether the printer sounds the tone when an error occurs.</td>
</tr>
<tr>
<td>Alert Tone</td>
<td>Specifies whether the printer sounds an alarm when an error occurs.</td>
</tr>
<tr>
<td>Out of Paper Alert Tone</td>
<td>Displays whether the printer sounds the tone when the paper runs out.</td>
</tr>
<tr>
<td>Low Toner Alert Tone</td>
<td>Displays whether the printer sounds the tone when the toner is low.</td>
</tr>
<tr>
<td>Time-Out</td>
<td>Specifies the amount of time the printer waits to receive additional bytes of data from the computer. When this timeout expires, the print job is canceled.</td>
</tr>
<tr>
<td>Device Language</td>
<td>Determine the language to be used for E-mail Alert.</td>
</tr>
<tr>
<td>Auto Log Print</td>
<td>Specifies whether the printer outputs logs automatically.</td>
</tr>
</tbody>
</table>

Printer Maintenance

The Printer Maintenance tab includes Paper Density, Adjust BTR, Adjust Fuser, Auto Registration Adjustment, Color Registration Adjustments, Adjust Altitude, Reset Defaults, Non-Dell Toner, Initialize PrintMeter, and Web Link Customization pages.

Paper Density

Purpose:

To specify the paper density.

Values:

<table>
<thead>
<tr>
<th>Plain Light</th>
<th>Sets the paper density in Light for the plain paper.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal</td>
<td>Sets the paper density in Normal for the plain paper.</td>
</tr>
</tbody>
</table>
**Adjust BTR**

**Purpose:**

To specify the reference voltage settings for the transfer roller.

**Values:**

<table>
<thead>
<tr>
<th>Label</th>
<th>Light</th>
<th>Sets the paper density in Light for the label.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Normal</td>
<td>Sets the paper density in Normal for the label.</td>
</tr>
</tbody>
</table>

| Plain     | Sets the reference voltage settings for the transfer roller for plain paper. |
| Plain Thick | Sets the reference voltage settings for the transfer roller for thick plain paper. |
| Covers    | Sets the reference voltage settings for the transfer roller for covers. |
| Covers Thick | Sets the reference voltage settings for the transfer roller for thick covers. |
| Label     | Sets the reference voltage settings for the transfer roller for labels. |
| Coated    | Sets the reference voltage settings for the transfer roller for coated paper. |
| Coated Thick | Sets the reference voltage settings for the transfer roller for thick coated paper. |
| Envelope  | Sets the reference voltage settings for the transfer roller for envelopes. |
| Recycled  | Sets the reference voltage settings for the transfer roller for recycled paper. |
| Coated JPN | Sets the reference voltage settings for the transfer roller for coated Japanese paper. |
| Postcard JPN | Sets the reference voltage settings for the transfer roller for Japanese postcards. |

**Adjust Fuser**

**Purpose:**

To specify the temperature settings value for the fuser.

**Values:**

| Plain     | Sets the temperature settings for the fuser for plain paper. |
| Plain Thick | Sets the temperature settings for the fuser for thick plain paper. |
| Covers    | Sets the temperature settings for the fuser for covers. |
| Covers Thick | Sets the temperature settings for the fuser for thick covers. |
| Label     | Sets the temperature settings for the fuser for labels. |
| Coated    | Sets the temperature settings for the fuser for coated paper. |
| Coated Thick | Sets the temperature settings for the fuser for thick coated paper. |
| Envelope  | Sets the temperature settings for the fuser for envelopes. |
| Recycled  | Sets the temperature settings for the fuser for recycled paper. |
| Coated JPN | Sets the temperature settings for the fuser for coated Japanese paper. |
| Postcard JPN | Sets the temperature settings for the fuser for Japanese postcards. |
Auto Registration Adjustment

Purpose:

Specifies whether to adjust the color registration automatically.

Values:

| Auto Registration Adjustment | Specifies whether to adjust the color registration automatically. |

Color Registration Adjustments

Purpose:

To print the color registration chart and to adjust the color registration by using the chart.

This function is required after the printer is set up or moved.

Values:

<table>
<thead>
<tr>
<th>Auto Correct</th>
<th>Click Start to adjust color registration automatically.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color Regi Chart</td>
<td>Click Start to print the color registration chart.</td>
</tr>
</tbody>
</table>

1 (Lateral) - Enter Number

<table>
<thead>
<tr>
<th>Yellow</th>
<th>Specifies the values for lateral that are found in the color registration chart.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Magenta</td>
<td></td>
</tr>
<tr>
<td>Cyan</td>
<td></td>
</tr>
</tbody>
</table>

2 (Process) - Enter Number

<table>
<thead>
<tr>
<th>Yellow</th>
<th>Specifies the values for process that are found in the color registration chart.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Magenta</td>
<td></td>
</tr>
<tr>
<td>Cyan</td>
<td></td>
</tr>
</tbody>
</table>

Adjust Altitude

Purpose:

To adjust the height of the installation location of the printer.

Values:

<table>
<thead>
<tr>
<th>0 meter</th>
<th>Select the value close to the height of the installation location of the printer.</th>
</tr>
</thead>
<tbody>
<tr>
<td>1000 meters</td>
<td></td>
</tr>
<tr>
<td>2000 meters</td>
<td></td>
</tr>
<tr>
<td>3000 meters</td>
<td></td>
</tr>
</tbody>
</table>
**Reset Defaults**

**Purpose:**

To initialize the non-volatile memory (NVM). After executing this function and rebooting the printer, all the menu parameters are reset to their default values.

**Values:**

| Reset Defaults and restart printer | Click Start to initialize the non-volatile memory (NVM) memory. |

**Non-Dell Toner**

**Purpose:**

Specifies whether to use the refilled toner cartridge or not. When this setting is on, you can use toner cartridges provided by other companies.

**Values:**

| Non-Dell Toner | Overrides factory toner cartridge setting. Using non-Dell-brand toner cartridges may make some printer features unusable, reduce print quality and decrease the reliability of your printer. Dell recommends only new Dell-brand toner cartridges for your printer. Dell does not provide warranty coverage for problems caused by using accessories, parts, or components not supplied by Dell. Using "Copy Printer Settings" will not copy the settings to another printer. |

**Initialize PrintMeter**

**Purpose:**

To initialize the data for the print meter. After executing this function to automatically restart the printer, the value of the meter resets to 0.

**Values:**

| Initialize PrintMeter | Click Start to initialize the print meter. |

**Web Link Customization**

**Purpose:**

To configure the link used for ordering supplies.

**Values:**

<table>
<thead>
<tr>
<th>Select Reorder URL</th>
<th>Specifies the URL that Order Supplies at links to in the left frame.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Regular</td>
<td>accessories.us.dell.com/sna</td>
</tr>
</tbody>
</table>
Print Server Settings

Use the Print Server Settings menu to set the type of printer interface and necessary conditions for communications.

The following tabbed pages are displayed in the top of the Right Frame.

Print Server Reports

The Print Server Reports tab includes Print Server Setup Page, and E-Mail Alert Setup Page.

Print Server Setup Page

Purpose:

To verify the current settings of TCP/IP (Transmission Control Protocol/Internet Protocol) protocol and printing ports. On this page, you can only verify the settings of items. If you want to change the settings, go to the pages in the Print Server Settings tab.

Values:

<table>
<thead>
<tr>
<th>Ethernet</th>
<th>Ethernet Settings</th>
<th>Displays the current settings of Ethernet transmission rate and the duplex settings.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current Ethernet Settings</td>
<td>Displays the current Ethernet settings.</td>
<td></td>
</tr>
<tr>
<td>MAC Address</td>
<td>Displays the printer's MAC (Media Access Control) address.</td>
<td></td>
</tr>
<tr>
<td>TCP/IP Settings</td>
<td>Host Name</td>
<td>Displays the host name.</td>
</tr>
<tr>
<td>Current DNS Server Address</td>
<td>Displays the DNS server address.</td>
<td></td>
</tr>
<tr>
<td>DNS</td>
<td>DNS Mode</td>
<td>Select the check box to get the DNS (Domain Name System) server address automatically from the DHCP (Dynamic Host Configuration Protocol) server.</td>
</tr>
<tr>
<td>MAC Address</td>
<td>Displays the printer's MAC (Media Access Control) address.</td>
<td></td>
</tr>
<tr>
<td>MAC Address</td>
<td>Displays the printer's MAC (Media Access Control) address.</td>
<td></td>
</tr>
<tr>
<td>Gateway Address</td>
<td>Displays the gateway address.</td>
<td></td>
</tr>
<tr>
<td>LPD (Line Printer Daemon)</td>
<td>Port Status</td>
<td>Displays the port status.</td>
</tr>
<tr>
<td>Port Number</td>
<td>Displays the number of connections received simultaneously by the client.</td>
<td></td>
</tr>
<tr>
<td>Port9100</td>
<td>Port Status</td>
<td>Displays the port status.</td>
</tr>
<tr>
<td>Connection Time-Out</td>
<td>Displays the connection timeout period.</td>
<td></td>
</tr>
<tr>
<td>HTTP</td>
<td>Port Status</td>
<td>Displays the HTTP (Hyper Text Transfer Protocol) port status.</td>
</tr>
<tr>
<td>Port Number</td>
<td>Displays the HTTP port number.</td>
<td></td>
</tr>
<tr>
<td>Port9100</td>
<td>Port Status</td>
<td>Displays the port status.</td>
</tr>
<tr>
<td>Connection Time-Out</td>
<td>Displays the connection timeout period.</td>
<td></td>
</tr>
<tr>
<td>FTP</td>
<td>Port Status</td>
<td>Displays the port status.</td>
</tr>
<tr>
<td>Port Number</td>
<td>Displays the port number.</td>
<td></td>
</tr>
<tr>
<td>Simultaneous Connections</td>
<td>Displays the number of connections received simultaneously by the client.</td>
<td></td>
</tr>
<tr>
<td>HTTP</td>
<td>Port Status</td>
<td>Displays the HTTP (Hyper Text Transfer Protocol) port status.</td>
</tr>
<tr>
<td>Port Number</td>
<td>Displays the HTTP port number.</td>
<td></td>
</tr>
<tr>
<td>Simultaneous Connections</td>
<td>Displays the number of connections received simultaneously by the client.</td>
<td></td>
</tr>
<tr>
<td>FTP</td>
<td>Port Status</td>
<td>Displays the port status.</td>
</tr>
<tr>
<td>Port Number</td>
<td>Displays the port number.</td>
<td></td>
</tr>
<tr>
<td>SNMP Agent</td>
<td>Port Status</td>
<td>Displays the port status.</td>
</tr>
<tr>
<td>Trap Notification (IP) 1-3</td>
<td>Displays the status of the Trap Notification (IP) feature and IP address.</td>
<td></td>
</tr>
<tr>
<td>Authenticate Error Trap</td>
<td>Displays the status of the Authenticate Error Trap.</td>
<td></td>
</tr>
</tbody>
</table>
E-Mail Alert Setup Page

Purpose:

To verify the current settings of SMTP/POP (Simple Mail Transfer Protocol/Post Office Protocol) used for the e-mail feature and E-Mail Alerts feature. In this page, you can only verify the settings of items. If you want to change the settings, go to the pages in the Print Server Settings tab.

Values:

<table>
<thead>
<tr>
<th>E-Mail Server Settings</th>
<th>Port Status</th>
<th>Displays the port status.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Primary SMTP Gateway</td>
<td>Displays the primary SMTP (Simple Mail Transfer Protocol) gateway.</td>
<td></td>
</tr>
<tr>
<td>SMTP Port Number</td>
<td>Displays the SMTP port number.</td>
<td></td>
</tr>
<tr>
<td>E-Mail Send Authentication</td>
<td>Displays the authentication method for outgoing e-mail.</td>
<td></td>
</tr>
<tr>
<td>POP3 Server Address</td>
<td>Displays the POP3 (Post Office Protocol 3) server address.</td>
<td></td>
</tr>
<tr>
<td>POP3 Port Number</td>
<td>Displays the POP3 port number.</td>
<td></td>
</tr>
<tr>
<td>Reply Address</td>
<td>Displays the IP address of servers connected with SMTP protocol when data is incoming.</td>
<td></td>
</tr>
<tr>
<td>SMTP Server Connection</td>
<td>Displays the status of the SMTP server connection.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>E-Mail Alert Settings</th>
<th>E-Mail List 1</th>
<th>Displays the acceptable e-mail addresses for the E-Mail Alert feature specified in E-mail List 1.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Alerts for List 1</td>
<td>Supplies Alerts</td>
<td>Displays the status, and whether to receive an E-Mail Alert for consumables.</td>
</tr>
<tr>
<td></td>
<td>Paper Handling Alerts</td>
<td>Displays the status, and whether to receive an E-Mail Alert for paper handling.</td>
</tr>
<tr>
<td></td>
<td>Service Call</td>
<td>Displays the status, and whether to receive an E-Mail Alert for Service Calls.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>E-Mail List 2</th>
<th>Displays the acceptable e-mail addresses for the E-Mail Alert feature specified in E-mail List 2.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Alerts for List 2</td>
<td>Supplies Alerts</td>
</tr>
<tr>
<td></td>
<td>Paper Handling Alerts</td>
</tr>
<tr>
<td></td>
<td>Service Call</td>
</tr>
</tbody>
</table>

Print Server Settings

The Print Server Settings tab includes Basic Information, Port Settings, TCP/IP, E-Mail Alert, and SNMP pages.

Basic Information

Purpose:

To configure the printer's basic information.

Values:

<table>
<thead>
<tr>
<th>System Settings</th>
<th>Printer Name</th>
<th>Specifies the name of the printer up to 31 alphanumeric characters.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Location</td>
<td>Specifies the location of the printer up to 63 alphanumeric characters.</td>
<td></td>
</tr>
<tr>
<td>Contact Person</td>
<td>Specifies the contact name, number, and other information of the printer administrator and service center up to 63 alphanumeric characters.</td>
<td></td>
</tr>
</tbody>
</table>
### Port Settings

**Purpose:**
To specify whether to enable or disable printing ports and management protocol features.

**Values:**

<table>
<thead>
<tr>
<th>Ethernet Settings</th>
<th>Auto</th>
<th>10Base-T Half-Duplex</th>
<th>10Base-T Full-Duplex</th>
<th>100Base-TX Half-Duplex</th>
<th>100Base-TX Full-Duplex</th>
</tr>
</thead>
</table>

- **Current Ethernet Settings:**
  - Displays the current settings of Ethernet.
- **MAC Address:**
  - Displays the printer’s MAC address.

#### Port Status

- **LPD:** Select the check box to enable the LPD.
- **Port9100:** Select the check box to enable the Port9100.
- **FTP:** Select the check box to enable the FTP port.
- **E-Mail Alert:** Select the check box to enable the E-Mail Alert feature.
- **SNMP Agent:** Select the check box to enable the SNMP (Simple Network Management Protocol). You can also configure the transport protocol to be used. UDP can be selected as the transport protocol.

**NOTE:** The settings in the Port Settings page will be valid only when the printer is rebooted. When you change or configure the settings, click the **Restart printer to apply new settings** button to apply new settings.

### TCP/IP

**Purpose:**
To configure the IP address, subnet mask, and gateway address of the printer.

**Values:**

<table>
<thead>
<tr>
<th>TCP/IP Settings</th>
<th>Host Name</th>
<th>IP Address Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>TCP/IP</strong></td>
<td>Specifies the host name up to 47 alphanumeric characters. The default name will remain valid if no entry is made.</td>
<td></td>
</tr>
<tr>
<td><strong>AutoIP</strong></td>
<td>Automatically sets the IP address.</td>
<td></td>
</tr>
<tr>
<td><strong>DHCP</strong></td>
<td>Uses DHCP to set the IP address.</td>
<td></td>
</tr>
<tr>
<td><strong>BOOTP</strong></td>
<td>Uses BOOTP (Bootstrap Protocol) to set the IP address.</td>
<td></td>
</tr>
</tbody>
</table>
### E-Mail Alert

**Purpose:**

To configure detailed settings for E-Mail Alert. This page can also be displayed by clicking E-Mail Alert in the Left Frame.

**Values:**

<table>
<thead>
<tr>
<th><strong>E-Mail Server Settings</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Primary SMTP Gateway</td>
<td>Sets the primary SMTP gateway.</td>
</tr>
<tr>
<td>SMTP Port Number</td>
<td>Specifies the SMTP port number. This must be 25 or between 5000 and 65535.</td>
</tr>
<tr>
<td>E-Mail Send Authentication</td>
<td>Specifies the authentication method for outgoing e-mail.</td>
</tr>
<tr>
<td>SMTP Login User</td>
<td>Specifies the SMTP login user. Up to 63 alphanumeric characters, periods, hyphens, under bars, and at symbols (@) can be used. If specifying more than one address, separate them using commas.</td>
</tr>
<tr>
<td>SMTP Login Password</td>
<td>Specifies the SMTP account password up to 31 alphanumeric characters.</td>
</tr>
<tr>
<td>POP3 Server Address*1</td>
<td>Specifies the POP3 server address in IP address format of &quot;aaa.bbb.ccc.ddd&quot; or as a DNS host name up to 63 characters.</td>
</tr>
<tr>
<td>POP3 Port Number*1</td>
<td>Specifies the POP3 server port number. This must be 110 or between 5000 and 65535.</td>
</tr>
<tr>
<td>POP User Name*1</td>
<td>Specifies the POP3 account user name. Up to 63 alphanumeric characters, periods, hyphens, under bars, and at symbols (@) can be used. If specifying more than one address, separate them using commas.</td>
</tr>
<tr>
<td>POP User Password*1</td>
<td>Specifies the POP3 account password up to 31 alphanumeric characters.</td>
</tr>
<tr>
<td>Reply Address</td>
<td>Designates the reply e-mail address sent with each E-Mail Alert.</td>
</tr>
<tr>
<td>SMTP Server Connection</td>
<td>Displays the status of the SMTP server connection.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>E-Mail Alert Settings</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>E-Mail List 1</td>
<td>Sets acceptable e-mail addresses for the E-Mail Alert feature up to 255 alphanumeric characters.</td>
</tr>
<tr>
<td>Select Alerts for List 1</td>
<td>Select the check box to receive an E-Mail Alert for consumables.</td>
</tr>
<tr>
<td>Supplies Alerts</td>
<td>Select the check box to receive an E-Mail Alert for consumables.</td>
</tr>
<tr>
<td>Paper Handling Alerts</td>
<td>Select the check box to receive an E-Mail Alert for paper handling.</td>
</tr>
</tbody>
</table>

---

**RARP**

Uses RARP (Reverse Address Resolution Protocol) to set the IP address.

**Manually Set**

Uses the control panel or the Dell Printer Configuration Web Tool to set the IP address manually.

**IP Address**

Sets the IP address allocated to the printer in the \texttt{nnn.nnn.nnn.nnn} format, where \texttt{nnn} is a variable between 0 and 255. Note that values 127 and 224-254 are not valid for the first three-digits.

**Subnet Mask**

Sets the subnet mask in the \texttt{nnn.nnn.nnn.nnn} format. Each section of \texttt{nnn.nnn.nnn.nnn} is a value between 0 and 255. Note that 255.255.255.255 is invalid.

**Gateway Address**

Sets the gateway address in the \texttt{nnn.nnn.nnn.nnn} format. Each section of \texttt{nnn.nnn.nnn.nnn} is a value between 0 and 254. Note that values 127 and 224-254 are not valid for the first three-digits.

**DNS**

- **DNS Mode**
  Select the check box to get the DNS server address automatically from the DHCP server.
- **DNS Server Address**
  Sets the DNS server address.
- **DNS Domain Name**
  Specifies the domain name of the domain name server. Up to 255 alphanumeric characters, periods, and hyphens can be used. If specifying more than one domain name, separate them using a comma or semicolon.

**LPD**

- **Connection Time-Out**
  Sets the connection timeout period from 1 to 1000 seconds.
- **IP Filter**
  To set the IP Filter settings, click IP Filter. The IP Filter page is displayed.

**Port9100**

- **Port Number**
  Sets the port number from 9000 to 9999.
- **Connection Time-Out**
  Sets the connection timeout period between 1 and 1000 seconds.
- **IP Filter**
  To set the IP Filter settings, click IP Filter. The IP Filter page is displayed.

**HTTP**

- **Port Number**
  Sets the port number to 80 or from 8000 to 9999.
- **Simultaneous Connections**
  Displays the maximum number of connections received simultaneously by the client.
- **Connection Time-Out**
  Sets the connection timeout period from 1 to 255 seconds.

**FTP**

- **Password**
  Sets whether to enable or disable the password. And also specifies the password value up to 7 characters.
- **Connection Time-Out**
  Sets the connection timeout period from 1 to 1000 seconds.
**SNMP**

**Purpose:**

To configure the detailed settings of SNMP.

**Values:**

<table>
<thead>
<tr>
<th>SNMP Agent</th>
<th>Community Name (Read only)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Specifies the community name to access (read only) the data up to 31 alphanumeric characters. The original setting will remain valid if no input is made. Characters entered for community name in previous settings will not be displayed on the screen. The default Read Community is public.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SNMP Agent</th>
<th>Community Name (Read/Write)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Specifies the community name to access (read and write) the data up to 31 alphanumeric characters. The original setting will remain valid if no input is made. Characters entered for community name in previous settings will not be displayed on the screen. The default Read/Write Community is private.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SNMP Agent</th>
<th>Community Name (Trap)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Specifies the community name used for trap up to 31 alphanumeric characters. The original setting will remain valid if no input is made. Characters entered for Community Name (Trap) in previous settings will not be displayed on the screen. The default Trap Community is &quot; &quot; (NULL).</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SNMP Agent</th>
<th>Trap Notification (IP) 1-3</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Select the check boxes to notify trap occurrence. In this case, specify the IP address and IP socket in the ( nnn.nnn.nnn.nnn:mmmmm ) format. Each section of &quot;nnn&quot; is a variable value between 0 and 255. Note that values 127 and 224-254 are not valid for the first three-digits only. IP socket mmmmm is a variable value between 0 and 65535.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SNMP Agent</th>
<th>Authenticate Error Trap</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Select the check box to notify Authenticate Error Trap.</td>
</tr>
</tbody>
</table>

*1 Available when POP before SMTP for E-Mail Send Authentication is selected.

**IP Filter**

**Purpose:**

To configure the detailed settings for the IP Filter used for LPD and Port9100.

**Values:**

<table>
<thead>
<tr>
<th>Address</th>
<th>Sets the address in the address field. Enter a numeric value between 0 and 255 in each field of &quot;aaa.bbb.ccc.ddd.&quot; However, 127 and 224-254 cannot be used to &quot;aaa.&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address Mask</td>
<td>Sets the Subnet Mask in the mask field. Enter a numeric value between 0 and 255 in each field.</td>
</tr>
<tr>
<td>Active Mode</td>
<td>Select the check box to receive an E-Mail Alert for Service Calls.</td>
</tr>
</tbody>
</table>

When you make the settings for the filter, enter the IP address of the IP Filter in the **Address** field and the Subnet Mask in the **Address Mask** field. Enter a numeric value between 0 and 255 in each field. "*" is appended to the current value.
**Setup Procedure**

You can set up to a maximum of five items and the first item takes priority. Enter the shortest address first before proceeding to the next longer address when setting multiple filters.

The following section explains how the **IP Filter** operates.

**IP Filter Procedure**

1. **Enabling Printing From a Specified User**

   The following describes the procedure to enable printing only from the "192.168.100.10" IP address.

   **Procedures:**
   a. Click the first column of **Access List** row 1.
   b. Enter "192.168.100.10" in the **Address** field and "255.255.255.255" in the **Address Mask** field.
   c. Select **Permit**.
   d. Click **Apply New Settings**.

2. **Disabling Printing From a Specified User**

   The following section describes the procedure to disable printing only from the "192.168.100.10" IP address.

   **Procedures:**
   a. Click the first column of **Access List** row 1.
   b. Enter "192.168.100.10" in the **Address** field and "255.255.255.255" in the **Address Mask** field.
   c. Select **Reject**.
   d. Click the first column of **Access List** row 2.
   e. Enter "0.0.0.0" in the **Address** field and "0.0.0.0" in the **Address Mask** field.
   f. Select **Permit**.
   g. Click **Apply New Settings**.

3. **Enabling and Disabling Printing from Network Addresses**

   You can enable printing from the "192.168" network address and disable printing from the "192.168.200" network address. However, the example below describes how to enable printing from the "192.168.200.10" IP address.

   **Procedures:**
   a. Click the first column of the **Access List** row 1.
   b. Enter "192.168.200.10" in the **Address** field and "255.255.255.255" in the **Address Mask** field.
   c. Select **Permit**.
   d. Click the first column of the **Access List** row 2.
   e. Enter "192.168.200.0" in the **Address** field and "255.255.255.0" in the **Address Mask** field.
   f. Select **Reject**.
   g. Click the first column of the **Access List** row 3.
   h. Enter "192.168.0.0" in the **Address** field and "255.255.0.0" in the **Address Mask** field.
   i. Select **Permit**.
   j. Click **Apply New Settings**.

**Other Features**

The **Other Features** tab includes **Set Password**, and **Reset Print Server** pages.

**Set Password**
Purpose:

To set or change the password that is required to access the printer setup parameters from the Dell Printer Configuration Web Tool.

Set the password of the Tool Box from Set Password in the Printer Maintenance tab. This page can also be displayed by clicking Set Password in the Left Frame.

**NOTE:** To restore the password to default (NULL), initialize the non-volatile memory (NVM).

Values:

<table>
<thead>
<tr>
<th>Administrator Password</th>
<th>Sets the password up to 10 alphanumeric characters. The password will appear as asterisks (*) in the field when it is entered.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Confirm Administrator Password</td>
<td>Enter the password again to confirm it.</td>
</tr>
</tbody>
</table>

**Reset Print Server**

Purpose:

To initialize NVRAM (non-volatile RAM) for the network feature and reboot the printer. You can also initialize the printer's NVRAM from Reset Defaults in the Printer Settings menu.

Values:

<table>
<thead>
<tr>
<th>Initialize NIC NVRAM Memory and restart printer.</th>
<th>Click the Start button to initialize NVRAM. Network settings will revert to the factory default settings and reboot the network capability.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Restart Printer</td>
<td>Click the Start button to reboot the printer.</td>
</tr>
</tbody>
</table>

**Copy Printer Settings**

The Copy Printer Settings menu includes the Copy Printer Settings and Copy Printer Settings Report pages.

**Copy Printer Settings**

Purpose:

To copy the printer settings to one or more of the same model of the printer.

To copy the settings to another printer, specify the IP address and password of the printer to which the settings are copied in the IP Address text box and Password text box. Then, click the Copy the settings to the Host in the above list button. Copying the settings is complete. The connection time-out period is 60 seconds. After that, you can check whether settings were copied to this page. And you need to check the Copy the settings to the Host in the above list and reboot the machine menu of the Dell Printer Configuration Web Tool in the destination printer to verify if settings were actually copied or not.

If the settings can be copied but printer configuration is different, the settings of only the same items are copied. Printer settings are simultaneously copied to printers of up to 10 IP addresses.

**Copy Printer Settings Report**

Purpose:
To verify the histories of copying.

NOTE: The history is cleared by turning off the printer.

Print Volume

The Printer Volume menu includes the Print Volume and Dell ColorTrack pages.

Print Volume

Purpose:

To verify the number of printed pages. This page can also be displayed by clicking Print Volume in the Left Frame.

Values:

<table>
<thead>
<tr>
<th>Printer Page Count</th>
<th>Displays the total number of pages printed since the printer was shipped from the factory.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper Used</td>
<td>Displays the number of pages for each paper size.</td>
</tr>
</tbody>
</table>

Dell ColorTrack

Purpose:

To specify which users have access to color printing and to limit print volume per user.

Values:

<table>
<thead>
<tr>
<th>Print User Limitation</th>
<th>Select the check box to restrict users from using the printer.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Permit printing without specifying user</td>
<td>Select the check box to use the printer without user limitations.</td>
</tr>
</tbody>
</table>

User Registration

Displayed when Print User Limitation is enabled. To register a user, click Edit User Registration to open the Edit Print User Registration page, and then specify User Registration No. and click Confirm/Change to open the Print User Settings page.
Print Media Guidelines

Print media is paper, labels, envelopes, and coated paper among others. Your printer provides high-quality printing on a variety of print media. Selecting the appropriate print media for your printer helps avoid printing troubles. This section describes selecting print media, caring for print media, and loading the print media in the tray 1.

- Paper
- Envelopes
- Labels
- Storing Print Media
- Identifying Print Media Sources and Specifications

Paper

For the best print quality in color, use 75 g/m² (20 lb) xerographic, grain long paper. For the best print quality in black and white, use 90 g/m² (24 lb) xerographic, grain long paper. Before buying large quantities of any print media, Dell recommends trying a sample first.

When loading paper, identify the recommended print side on the paper package, and load the paper accordingly. See "Loading Print Media in Tray 1" and "Loading the Single Sheet Feeder" for detailed loading instructions.

Paper Characteristics

The following paper characteristics affect print quality and reliability. Dell recommends that you follow these guidelines when evaluating new paper stock.

Weight

The tray automatically feeds paper weights from 60 to 216 g/m² (16 to 60 lb bond) grain long. The single sheet feeder automatically feeds paper weights from 60 to 216 g/m² (16 to 80 lb bond) grain long. Paper lighter than 60 g/m² (16 lb) may not feed properly, and could cause paper jams. For best performance, use 75 g/m² (20 lb bond) grain long paper.

Curl

Curl is the tendency of print media to curve at its edges. Excessive curl can cause paper feeding problems. Curl usually occurs after the paper passes through the printer, where it is exposed to high temperatures. Storing paper unwrapped, even in the paper tray, can contribute to paper curling prior to printing and cause feeding problems regardless of humidity. When printing on curled paper, straighten the paper and then insert it into the single sheet feeder.

Smoothness

The degree of paper smoothness directly affects print quality. If the paper is too rough, the toner does not fuse to the paper properly, resulting in poor print quality. If the paper is too smooth, it can cause paper feeding problems. Smoothness between 150 and 250 Sheffield points produces the best print quality.

Moisture Content

The amount of moisture in the paper affects both print quality and the ability of the printer to feed the paper properly. Leave the paper in its original packaging until you are ready to use it. This limits the exposure of the paper to moisture changes that can degrade its performance.

Grain Direction

Grain refers to the alignment of the paper fibers in a sheet of paper. Grain is either grain long, running the length of the paper, or grain short, running the width of the paper. For 60 to 135 g/m² (16 to 36 lb bond) paper, grain long fibers are recommended. For papers heavier than 135 g/m² (36 lb bond), grain short is preferred.

Fiber Content
Most high-quality xerographic paper is made from 100% chemically pulped wood. Paper containing fibers such as cotton possess characteristics that can result in degraded paper handling.

**Recommended Paper**

To ensure the best print quality and feed reliability, use 75 g/m² (20 lb) xerographic paper. Business papers designed for general business use also provide acceptable print quality. Only use paper able to withstand high temperatures without discoloring, bleeding, or releasing hazardous emissions. The laser printing process heats paper to high temperatures. Check with the manufacturer or vendor to determine whether the paper you have chosen is acceptable for laser printers.

Always print several samples before buying large quantities of any type of print media. When choosing any print media, you should consider the weight, fiber content, and color.

**Unacceptable Paper**

The following paper types are not recommended for use with the printer:

- Chemically treated papers used to make copies without carbon paper, also known as carbonless papers, carbonless copy paper (CCP), or no carbon required (NCR) paper
- Preprinted papers with chemicals that may contaminate the printer
- Preprinted papers that can be affected by the temperature in the printer fuser
- Preprinted papers that require a registration (the precise print location on the page) greater than ±0.09 inches, such as optical character recognition (OCR) forms
  
  In some cases, you can adjust registration with your software program to successfully print on these forms.
- Coated papers (erasable bond), synthetic papers, thermal papers
- Rough-edged, rough or heavily textured surface papers, or curled papers
- Recycled papers containing more than 25% post-consumer waste that do not meet DIN 19 309
- Multiple-part forms or documents
- Print quality may deteriorate (blank spaces or blotches may appear in the text) when printing on talc or acid paper.

**Selecting Paper**

Proper paper selection helps prevent jams and ensures trouble-free printing.

To help avoid jams or poor print quality:

- Always use new, undamaged paper.
- Before loading the paper, identify the recommended print side of the paper. This information is usually indicated on the paper package.
- Do not use paper that you have cut or trimmed yourself.
- Do not mix print media sizes, weights, or types in the same source. This may result in a paper jam.
- Do not remove the tray while a job is printing.
- Ensure that the paper is properly loaded in the tray.
- Flex paper back and forth, and then fan them. Straighten the edges of the stack on a level surface.
Selecting Preprinted Forms and Letterhead

When selecting preprinted forms and letterhead paper for the printer:

- Use grain long papers for best results.
- Use only forms and letterhead printed using an offset lithographic or engraved printing process.
- Select papers that absorb ink, but do not bleed.
- Avoid papers with rough or heavily textured surfaces.
- Use papers printed with heat-resistant inks designed for use in xerographic copiers. The ink must withstand temperatures of 225°C (437°F) without melting or releasing hazardous emissions.
- Use inks that are not affected by the resin in toner or the silicone in the fuser. Inks that are oxidation-set or oil-based should meet these requirements; latex inks might not. If you are in doubt, contact your paper supplier.

Printing on Letterhead

Check with the manufacturer or vendor to determine whether the pre-printed letterhead you have selected is acceptable for laser printers.

Page orientation is important when printing on letterhead. Use the following table for help when loading letterhead in the print media sources.

<table>
<thead>
<tr>
<th>Print media source</th>
<th>Print side</th>
<th>Page orientation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tray 1</td>
<td>Face up</td>
<td>Letterhead enters the printer last</td>
</tr>
<tr>
<td>Single sheet feeder</td>
<td>Face down</td>
<td>Letterhead enters the printer first</td>
</tr>
</tbody>
</table>

Selecting Pre-Punched Paper

Pre-punched paper brands can differ in the number and placement of holes and in manufacturing techniques. However, it may not be possible to print on the paper to depending on the placement of holes on the paper.

To select and use pre-punched paper:

- Test paper from several manufacturers before ordering and using large quantities of pre-punched paper.
Paper should be punched at the paper manufacturer and not drilled into paper already packaged in a ream. Drilled paper can cause jams when multiple sheets feed through the printer. This may result in a paper jam.

Pre-punched paper can include more paper dust than standard paper. Your printer may require more frequent cleaning and feed reliability may not be as good as standard paper.

Weight guidelines for pre-punched paper are the same as non-punched paper.

### Envelopes

Depending on the choice of envelopes, it is possible to expect variable levels of light wrinkling. Before buying large quantities of any print media, Dell recommends trying a sample first. See "Loading Print Media in Tray 1" or "Loading the Single Sheet Feeder" for instructions on loading an envelope.

When printing on envelopes:

- Use only high-quality envelopes that are designed for use in laser printers.
- Set the print media source to the single sheet feeder or Tray 1. Set the paper type to Envelope, and select the correct size of envelope from the printer driver.
- For best performance, use envelopes made from 75 g/m² (20 lb bond) paper. You can use up to 105 g/m² (28 lb bond) weight for the envelope feeder as long as the cotton content is 25% or less. Envelopes with 100% cotton content must not exceed 90 g/m² (24 lb bond) weight.
- Use only new, undamaged envelopes.
- Use envelopes that can withstand temperatures of 205°C (401°F) without sealing, excessive curling, wrinkling, or releasing hazardous emissions. If you have any doubts about the envelopes you are considering, check with the envelope supplier.
- Adjust the guide to fit the width of the envelopes.
- To load envelope in the single sheet feeder, insert the envelopes with the flaps closed and the short-edge of the envelopes facing into the printer. The print side must be facing down.
- See "Loading Print Media in Tray 1" or "Loading the Single Sheet Feeder" for instructions on loading an envelope.
- Use one envelope size during a print job.
- Ensure the humidity is low because high humidity (more than 60%) and the high printing temperatures may seal the envelopes.
- For best performance, do not use envelopes that:
  - Have excessive curl or twist
  - Are stuck together or damaged in any way
  - Contain windows, holes, perforations, cutouts, embossing
  - Use metal clasps, string ties, or metal folding bars
  - Have an interlocking design
  - Have postage stamps attached
  - Have any exposed adhesive when the flap is in the sealed or closed position
  - Have nicked edges or bent corners
  - Have rough, cockle, or laid finishes

### Labels

Your printer can print on many labels designed for use with laser printers. Dell recommends feeding Labels from Tray 1. Label adhesives, face sheet (printable stock), and topcoats must be able to withstand temperatures of 205°C (401°F) and pressure of 25 pounds per square inch (psi). Before buying large quantities of any print media, Dell recommends trying a sample first.

When printing on labels:
- Set the paper type to **Label** from the printer driver.

- Do not load labels together with paper in the same tray. This may result in a jam.

- Do not use label sheets with a slick backing material.

- Do not print within 1 mm (0.04 inches) of the die cut.

- Use full label sheets. Partial sheets may cause labels to peel off during printing, resulting in a jam. Partial sheets also contaminate your printer and your cartridge with adhesive, and could void your printer and cartridge warranties.

- Use labels that can withstand temperatures of 205°C (401°F) without sealing, excessive curling, wrinkling, or releasing hazardous emissions.

- Do not print within 1 mm (0.04 inches) of the edge of the label, of the perforations, or between die-cuts of the label.

- Do not use label sheets that have adhesive to the edge of the sheet. Dell recommends zone coating of the adhesive at least 1 mm (0.04 inches) away from edges. Adhesive material contaminates your printer and could void your warranty.

- If zone coating of the adhesive is not possible, a 3 mm (0.125 inches) strip should be removed on the leading and driver edge, and a non-oozing adhesive should be used.

- Remove a 3 mm (0.125 inches) strip from the leading edge to prevent labels from peeling inside the printer.

- Portrait orientation is preferred, especially when printing bar codes.

- Do not use labels that have exposed adhesive.

---

**Storing Print Media**

For proper print media storage, the following guidelines help avoid media feeding problems and uneven print quality.

- For best results, store print media in an environment where the temperature is approximately 21°C (70°F) and the relative humidity is 40%.

- Store cartons of print media on a pallet or shelf, rather than directly on the floor.

- If you store individual packages of print media out of the original carton, ensure that they rest on a flat surface so that the edges do not buckle or curl.

- Do not place anything on top of the print media packages.

---

**Identifying Print Media Sources and Specifications**

The following tables provide information on standard and optional print media sources.

**Print Media Sizes and Support**

<table>
<thead>
<tr>
<th>Print Media Size</th>
<th>Single sheet feeder</th>
<th>Tray 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>A4 (210x297 mm)</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>B5 (182x257 mm)</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>A5 (148x110 mm)</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Youkei 2 (114x162mm)</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Youkei 3 (98x148mm)</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Youkei 4 (105x235mm)</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Youkei 6 (98x190mm)</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Youchoukei 3 (120x235mm)</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Choukei 3 (120x235mm)</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Choukei 4 (90x205mm)</td>
<td>Y</td>
<td>Y</td>
</tr>
</tbody>
</table>
## Print Media Supported

<table>
<thead>
<tr>
<th>Media</th>
<th>Single sided printing</th>
<th>Duplex printing</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Single sheet feeder</td>
<td>Tray 1</td>
</tr>
<tr>
<td>Plain</td>
<td>Y*</td>
<td>Y*</td>
</tr>
<tr>
<td>Plain - Side 2</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Plain Thick</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Plain Thick - Side 2</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Recycled</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Recycled - Side 2</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Label</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Covers</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Covers - Side 2</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Covers Thick</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Covers Thick - Side 2</td>
<td>Y</td>
<td>N</td>
</tr>
<tr>
<td>Envelope</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Postcard JPN</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Postcard JPN - Side 2</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>Coated JPN</td>
<td>Y</td>
<td>N</td>
</tr>
<tr>
<td>Coated JPN - Side 2</td>
<td>Y</td>
<td>N</td>
</tr>
<tr>
<td>Coated</td>
<td>Y</td>
<td>N</td>
</tr>
<tr>
<td>Coated - Side 2</td>
<td>Y</td>
<td>N</td>
</tr>
<tr>
<td>Coated Thick</td>
<td>Y</td>
<td>N</td>
</tr>
</tbody>
</table>

* Values marked by an asterisk (*) are the factory default menu settings.

## Setup Paper Type

<table>
<thead>
<tr>
<th>Paper type</th>
<th>Weight (gsm)</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain Paper</td>
<td>60-90</td>
<td>-</td>
</tr>
<tr>
<td>Plain Thick Paper</td>
<td>80/90-105</td>
<td>-</td>
</tr>
<tr>
<td>Covers</td>
<td>106-163</td>
<td>-</td>
</tr>
<tr>
<td>Covers Thick</td>
<td>164-216</td>
<td>-</td>
</tr>
<tr>
<td>Coated</td>
<td>106-163 (Low Speed)</td>
<td>Inkjet printer paper cannot be used.</td>
</tr>
<tr>
<td>---------</td>
<td>---------------------</td>
<td>-------------------------------------</td>
</tr>
<tr>
<td>Coated Thick</td>
<td>164-216 (Low Speed)</td>
<td>Inkjet printer paper cannot be used.</td>
</tr>
<tr>
<td>Coated JPN</td>
<td>95-105 (Mid Speed)</td>
<td>-</td>
</tr>
<tr>
<td>Label</td>
<td>3R7408</td>
<td>Inkjet printer paper cannot be used.</td>
</tr>
<tr>
<td>Envelopes</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>
Loading Print Media

Loading print media properly helps prevent jams and ensures trouble-free printing.

Before loading print media, identify the recommended print side of the print media. This information is usually on the print media package.

- Tray 1
- Loading Print Media in Tray 1
- Single Sheet Feeder
- Loading the Single Sheet Feeder
- Using the Single Sheet Feeder
- Using the Manual Duplex Function
- Manual Duplex Printing from Tray 1
- Manual Duplex Printing From the Single Sheet Feeder
- Using the Output Tray
- Using the Output Tray Extension

Tray 1

Capacity

Tray 1 can hold:

- 250 sheets of the standard paper.

Print Media Dimensions

Tray 1 accepts print media within the following dimensions:

- Width - 76.2 mm (3.00 inches) to 220.0 mm (8.66 inches)
- Length - 127 mm (5.00 inches) to 355.6 mm (14.00 inches)

Loading Print Media in Tray 1

**NOTE:** To avoid paper jams, do not remove the tray while a printing is in progress.

**NOTE:** Use only laser print media. Do not use ink jet paper in the printer.

1. Remove the paper tray from the printer.
2. Adjust the paper guides so they rest against the edges of the paper.

3. Before loading the print media, flex the sheets back and forth, and then fan them. Straighten the edges of the stack on a level surface.

4. Place the print media into the tray with the recommended print side face up.

5. Adjust the width guides until they rest lightly against the edges of the stack of paper.

**NOTE:** When you feed paper from the tray loaded with Legal size paper, extend the rear side of the tray.

**NOTE:** Do not exceed the maximum fill line in the tray. Overfilling the tray may cause paper jams.

6. After confirming that the guides are securely adjusted, insert the tray into the printer and extend the output tray on the top of the printer.

**Loading Letterhead**

The letterhead must be toward the top edge of the tray 1 with the print side facing up. However, the letterhead must be inserted top edge first with the print side facing down when loading paper into the single sheet feeder.
Loading the Envelope

To load an envelope in Tray 1, load envelopes with the flaps closed when the short edges of the envelopes enter the printer, or with the flaps open when the long edges of the envelopes enter the printer.

Single Sheet Feeder

Capacity

The single sheet feeder can hold:

- 1 sheet of the standard paper.

Print Media Dimensions

The single sheet feeder accepts print media within the following dimensions:

- Width - 76.2 mm (3.00 inches) to 220.0 mm (8.66 inches)
- Length - 127 mm (5.00 inches) to 355.6 mm (14.00 inches)

Loading the Single Sheet Feeder

In addition to plain paper, the single sheet feeder can be used various other sizes and types of print media such as an envelope.

1. Adjust the paper guides to the print media's width.

2. Hold both sides of the print media facing down close to the single sheet feeder, and push it 8-9 cm (4 inches) into the feeder until it automatically feeds.
Loading the Envelope

To load an envelope in the single sheet feeder, insert the envelope with the flap closed when the short edge of the envelope faces into the printer. Place the envelope with the print side facing down and slide the envelope into the entry slot.

NOTE: Do not force the print media into the single sheet feeder.

NOTICE: Never use the envelope with windows, coated linings, or self-stick adhesives. These lead to paper jams and can cause damage to the printer.

NOTE: Ensure that you set the envelope with the flaps completely closed.

Using the Single Sheet Feeder

- Insert an envelope with the flap side face down and with the stamp area on the top right side.
- Load letterhead face-down, with the top of the sheet entering the printer first.
- If you experience problems with paper feed, turn the paper around.

Using the Manual Duplex Function

Manual Duplex printing (or two-sided printing) allows you to print on both sides of a sheet of paper. For sizes that are acceptable for duplex printing, see "Print Media Sizes and Support."

Using Booklet Print

NOTE: You cannot use booklet print with the single sheet feeder.

To use booklet print, you must select either Flip on Short Edge or Flip on Long Edge from the Duplex menu in the Printing Preferences dialog box and then select Booklet Creation in the Booklet/Poster/Mixed Document dialog box displayed by clicking the Booklet/Poster/Mixed Document button. From the Duplex menu, you can define the way two-sided print pages are bound, and how the printing on the back of the sheet (even-numbered pages) is oriented in relation to the printing on the front (odd-numbered pages).

<table>
<thead>
<tr>
<th>Flip on Long Edge</th>
<th>Assumes binding along the long edge of the page (left edge for portrait orientation and top edge for landscape orientation). The following illustration shows long-edge binding for portrait and landscape pages:</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Long Edge Illustration" /></td>
<td>2 3</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Flip on Short Edge</th>
<th>Assumes binding along the short edge of the page (top edge for portrait orientation and left edge for landscape orientation). The following illustration shows short-edge binding for portrait and landscape pages:</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image2.png" alt="Short Edge Illustration" /></td>
<td>2 3</td>
</tr>
</tbody>
</table>
Manual Duplex Printing from Tray 1

Setting Method for Manual Duplex from Tray 1

When you start manual duplex printing, the instruction windows appears. Note that you cannot display this window again if you close the window. Do not close the window until duplex printing is complete.

1. First print the even pages. For a six page document, even pages are printed in the order page 6, page 4, then page 2. The Continue button blinks when the even pages finish printing.

2. Next stack the prints and set them as they are (with the blank side face up) into the paper tray. Pages are printed in the order page 1, page 3, then page 5.

**NOTE:** Printing on both sides of the paper is not possible if the document consists of various sizes of papers.

Manual Duplex Printing From the Single Sheet Feeder

**NOTE:** When printing on curled paper, straighten the paper and then insert it into the single sheet feeder.

Setting Method for Manual Duplex from the Single Sheet Feeder

When you start manual duplex printing, the instruction windows appears. Note that you cannot display this window again if you close the window. Do not close the window until duplex printing is complete.

1. First print the even pages. For a six page document, even pages are printed in the order page 2, page 4, then page 6. The Continue button blinks when the even pages finish printing.
2. After the even pages have finished printing out, stack the prints and turn the stack over.

   **NOTE:** Warped or curled prints can cause paper jams. Straighten them before setting them.

3. Next print the odd pages. One sheet at a time, set the very top print that was turned over as it is with the blank side face down, then press the Continue button. Print pages in the order page 1 (rear of page 2), page 3 (rear of page 4), then page 5 (rear of page 6).

   Example: When duplex printing a four page document onto two sheets.

   Set one page at a time in the manual feed tray in the order page 2 (rear) → page 4 (rear) → page 1 (front) → page 3 (front).

   **NOTE:** Printing on both sides of the paper is not possible if the document consists of various sizes of papers.

---

**Using the Output Tray**

The output tray holds up to:

1. 150 sheets of plain paper

---

**Using the Output Tray Extension**

The output tray extension is designed to prevent print media from falling from the printer after the print job is complete.

Before printing a document, ensure that the output tray extension is fully extended.
Operator Panel

- Using the Operator Panel
- Understanding the Operator Panel Lights
- Restoring the factory settings

Using the Operator Panel

The printer operator panel has two buttons and several indicators that show the status of the printer.

1. Continue button/indicator
   - Press this button to start single sheet feeder or duplex printing.
   - Press and hold this button to print the Report page.

2. Ready/Data indicator
   - Indicates the printer status, such as receiving and printing data.
   - Green on: The printer is ready.
   - Green blinks: Processing or printing or Warming up.
   - Orange on: The Power saver mode or Standby mode.

3. Tray 1 indicator
   - Indicates the status of the Tray 1.

4. Single sheet feeder indicator
   - Indicates the status of the shingle sheet feeder.

5. Toner indicators
   - Indicates the toner is low or empty.

6. Error indicator
   - Lights when an error occurred.
   - Orange on: The PHD (Print Head Device), or belt unit, life is coming to an end. Clean the CTD sensor.
   - Orange blinks: An error occurred.
   - Orange blinks: The PHD, or belt unit life is over. Clean the CTD sensor.

7. Jam/Front Cover Open indicator
   - Indicates that a paper jam occurred or the front cover is open.

8. Cancel button
   - Press this button to cancel a job.

For details on each indicator, see the table below:

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Status</th>
<th>Condition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Continue</td>
<td>Green on</td>
<td>Press the Continue button to start single sheet feeder printing.</td>
</tr>
<tr>
<td></td>
<td>Green blinks</td>
<td></td>
</tr>
<tr>
<td>Ready/Data</td>
<td>Green on</td>
<td>The printer is ready.</td>
</tr>
<tr>
<td></td>
<td>Green blinks</td>
<td>Processing or printing or Warming up.</td>
</tr>
<tr>
<td></td>
<td>Orange on</td>
<td>The Power saver mode or Standby mode.</td>
</tr>
<tr>
<td>Error</td>
<td>Orange on</td>
<td>The PHD (Print Head Device), or belt unit, life is coming to an end. Clean the CTD sensor.</td>
</tr>
<tr>
<td></td>
<td>Orange blinks</td>
<td>An error occurred.</td>
</tr>
<tr>
<td></td>
<td>Orange blinks</td>
<td>The PHD, or belt unit life is over. Clean the CTD sensor.</td>
</tr>
<tr>
<td>Tray</td>
<td>Green on</td>
<td>Paper is set on the tray.</td>
</tr>
<tr>
<td></td>
<td>Green blinks</td>
<td>Reload paper on the tray.</td>
</tr>
</tbody>
</table>
Understanding the Operator Panel Lights

The operator panel lights mean different things, depending on their sequence. Orange or green lights that are off, on, and/or blinking indicate printer conditions such as printer status, intervention (for example, out of paper), or service.

### Common Light Sequences

The following table shows the most common light status.

<table>
<thead>
<tr>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>Printer status</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Ready</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Processing</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Printing</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Canceling</td>
</tr>
</tbody>
</table>
**Paper Conditions**

The following table shows the paper status.

<table>
<thead>
<tr>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>Printer status</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Paper is loaded in the Tray 1.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Paper is loaded in the single sheet feeder.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>The toner is low in the specified toner cartridge.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Non Dell toner is used in the toner cartridge.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Life warning in the PHD unit</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Life warning in the belt unit</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Clean the CTD sensor.</td>
</tr>
</tbody>
</table>

* Orange on in all toner indicators.
The following conditions prompt you to load paper and press the Continue key. Click the links in the right column for more information on what it means and what you can do.

<table>
<thead>
<tr>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Load paper for side 2 in the Tray 1. See &quot;Manual Duplex Printing from Tray 1.&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Press the Continue key. See &quot;Manual Duplex Printing from Tray 1.&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Load paper for side 2 in the single sheet feeder. See &quot;Manual Duplex Printing From the Single Sheet Feeder.&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Press the Continue key. See &quot;Manual Duplex Printing From the Single Sheet Feeder.&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Load paper in the Tray 1. See &quot;Loading Print Media in Tray 1.&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Load paper in the Tray 1. See &quot;Loading Print Media in Tray 1.&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Load paper in the single sheet feeder. See &quot;Loading the Single Sheet Feeder.&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Load paper in the single sheet feeder. See &quot;Loading the Single Sheet Feeder.&quot;</td>
</tr>
</tbody>
</table>

Energy Saver mode is turned on. Turn it off.

When an Error Occurred

The following table shows the location where an error occurred.

<table>
<thead>
<tr>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>Printer status</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Paper jam occurred. See &quot;Clearing Jams.&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>The front cover is open.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Paper jam occurred in the Tray 1. See &quot;Clearing Paper Jams From the Tray 1.&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Paper jam occurred in the single sheet feeder. See &quot;Clearing Paper Jams From the Single Sheet Feeder.&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>The wrong size of paper size is loaded in the Tray 1. See &quot;Identifying Print Media Sources and Specifications.&quot;</td>
</tr>
</tbody>
</table>
Operator Call Errors

Press and hold the Continue button when an error occurs. You can obtain the detailed information from the operator call error.

<table>
<thead>
<tr>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5-K</th>
<th>5-C</th>
<th>5-M</th>
<th>5-Y</th>
<th>6</th>
<th>7</th>
<th>Error status</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>-</td>
<td></td>
<td>-</td>
<td></td>
<td>-</td>
<td>-</td>
<td>Memory overflow</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>-</td>
<td></td>
<td>-</td>
<td></td>
<td>-</td>
<td>-</td>
<td>PDL (Page Description Language) error</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>-</td>
<td></td>
<td>-</td>
<td></td>
<td>-</td>
<td>-</td>
<td>Invalid job environment</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>-</td>
<td></td>
<td>-</td>
<td></td>
<td>-</td>
<td>-</td>
<td>The side cover is open.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>-</td>
<td></td>
<td>-</td>
<td></td>
<td>-</td>
<td>-</td>
<td>Dell ColorTrack - Invalid user</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>-</td>
<td></td>
<td>-</td>
<td></td>
<td>-</td>
<td>-</td>
<td>Dell ColorTrack - Disabled function</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>-</td>
<td></td>
<td>-</td>
<td></td>
<td>-</td>
<td>-</td>
<td>Dell ColorTrack - Reached limit</td>
</tr>
</tbody>
</table>

The wrong size of paper is loaded in the single sheet feeder. See "Identifying Print Media Sources and Specifications."

An error occurred in the specified toner cartridge. See "Replacing Toner Cartridges."

The toner is empty in the specified toner cartridge. See "Replacing Toner Cartridges."

The life of the PHD unit is over.

The life of the belt unit is over.

Clean the CTD sensor.
**Toner Errors**

<table>
<thead>
<tr>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>Toner status</th>
</tr>
</thead>
<tbody>
<tr>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>The specified toner is not installed.</td>
</tr>
<tr>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>The low toner in the specified toner cartridge.</td>
</tr>
<tr>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>The CRUM ID error in the specified toner cartridge.</td>
</tr>
</tbody>
</table>

**Errors in the PHD Unit, Belt Unit, Fuser Unit, and CTD Sensor**

<table>
<thead>
<tr>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5-K</th>
<th>5-C</th>
<th>5-M</th>
<th>5-Y</th>
<th>6</th>
<th>7</th>
<th>Error status</th>
</tr>
</thead>
<tbody>
<tr>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>The PHD unit is removed.</td>
</tr>
<tr>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>The life of the PHD unit is over.</td>
</tr>
<tr>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>PHD CRUM ID error</td>
</tr>
<tr>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>The tapes are not removed from the PHD unit.</td>
</tr>
<tr>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>The belt unit life is over.</td>
</tr>
<tr>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>The CTD sensor is dirty.</td>
</tr>
</tbody>
</table>

**Fatal Errors**

The following table shows fatal errors. Contact your Dell supplier to notify the printer status associated with each error.

<table>
<thead>
<tr>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5-K</th>
<th>5-C</th>
<th>5-M</th>
<th>5-Y</th>
<th>6</th>
<th>7</th>
<th>Printer status</th>
</tr>
</thead>
<tbody>
<tr>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>ROS failure</td>
</tr>
<tr>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>Fuser failure</td>
</tr>
<tr>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>NVRAM (JOT) error</td>
</tr>
</tbody>
</table>
### ESS-Related Errors

<p>| | | | | | | | | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**ESS-Related Errors**

- CTD (Conductivity Temperature Depth) sensor failure
- Fan motor failure
- Motor failure
- MCU (Machine Control Unit) error
- Environmental sensor failure
- Solenoid error in the K mode.
- PageC timeout error

<table>
<thead>
<tr>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5-K</th>
<th>5-C</th>
<th>S-M</th>
<th>S-Y</th>
<th>6</th>
<th>?</th>
<th>Error Status</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>ESS Data Cache Error</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>ESS Instruction Error</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>ESS Illegal Exception</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>ASIC Failure</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>ESS On-Board RAM W/R Check Failure</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>ESS ROM Check Failure</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>ESS NVRAM1 W/R Check Failure</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>ESS NVRAM2 W/R Check Failure</td>
</tr>
</tbody>
</table>
You can restore the factory settings for your printer if you cannot use the printer with your computer.

**NOTE:** You can only initialize user-defined settings.

To restore the factory settings:

1. Ensure that the printer is turned off.
2. Open the side cover.
3. While holding down the Continue and Cancel buttons at the same time, turn on the printer.
4. After all the indicators are turned on, release the Continue and Cancel buttons.
5. After the Continue, Error, and Ready/Data indicators go out, close the side cover.
   
   The printer automatically:
   
   - Initializes the non-volatile memory (NVM).
   - Restarts.
   - Prints the Printer Settings and Device Settings pages.
6. Check if the factory settings are restored by referring to the Printer Settings and Device Settings pages.

Restoring the factory settings

You can restore the factory settings for your printer if you cannot use the printer with your computer.

**NOTE:** You can only initialize user-defined settings.

To restore the factory settings:

1. Ensure that the printer is turned off.
2. Open the side cover.
3. While holding down the Continue and Cancel buttons at the same time, turn on the printer.
4. After all the indicators are turned on, release the Continue and Cancel buttons.
5. After the Continue, Error, and Ready/Data indicators go out, close the side cover.
   
   The printer automatically:
   
   - Initializes the non-volatile memory (NVM).
   - Restarts.
   - Prints the Printer Settings and Device Settings pages.
6. Check if the factory settings are restored by referring to the Printer Settings and Device Settings pages.
You can change most system settings from your software programs. If your printer is attached to the network, you can change settings from the Dell Printer Configuration Web Tool. To launch the Dell Printer Configuration Web Tool, type the printer IP address in your Web browser. To find your printer's IP address, see "Printing a Printer Settings Page".

Settings from the software program update the default system settings for the printer. Settings from the printer driver only apply to the job you are sending to the printer.

If you cannot change a setting from your software program, use the Dell Printer Configuration Web Tool. Changing a system setting from the Tool Box or from the Dell Printer Configuration Web Tool makes that setting the user default.

### Printing a Printer Settings Page

You can verify the detailed system settings by printing a printer settings page.

1. Click Start ® All Programs ® Dell Printers ® Additional Color Laser Software ® Status Monitor Console. The Printer Selection dialog box opens.
2. Click Dell Color Laser 1320c listed in Printer Name. The Dell Color Laser 1320c Launcher window opens.
3. Click the Tool Box button. The Tool Box opens. You can also launch the Tool Box from the printer icon on the taskbar.
4. Click the Printer Settings Report tab.
5. Select Reports from the list at the left side of the page. The Reports page is displayed.
6. Click the Start button for Printer Settings. The Printer Settings page is printed.

You can also print the printer settings page by the following.

- Press and hold the Continue button on the printer until the Ready/Data indicator blinks.

**NOTE:** You cannot print a printer settings page by pressing and holding the Continue button if the password is specified in Set Password of the Tool Box (because the operator panel is locked).

### Using the Tool Box to Change the Printer Settings

You can select menu items and corresponding values from the Tool Box.

Factory defaults may vary for different countries.

These settings are active until new ones are selected or the factory defaults are restored.

To select a new value as a setting:
Using the Dell Printer Configuration Web Tool to Change System Settings

If your printer is connected to the network, you can change the device settings from your Web browser. If you are a network administrator, you can clone the system settings of one printer to one or all printers on the network.

Type your network printer IP address in your Web browser. Choose Printer Settings from the topics list, and then select the system settings you want to change.

To copy your system settings to another printer on the network, choose Copy Printer Settings from the topics list, and then type the other printer's IP address.

If you do not know your printer IP address, see the printer settings page. To print a printer settings page:

1. Click Start® All Programs® Dell Printers® Additional Color Laser Software® Status Monitor Console. The Printer Selection dialog box opens.
2. Click Dell Color Laser 1320c listed in Printer Name. The Dell Color Laser 1320c Launcher window opens.
3. Click the Tool Box button. The Tool Box opens. You can also launch the Tool Box from the printer icon on the taskbar.
4. Click the Printer Settings Report tab.
5. Select TCP/IP Settings from the list at the left side of the page.

Resetting Defaults

After executing this function and rebooting the printer, all the menu parameters, except the parameters for the network, are reset to their default values.

1. Click Start® All Programs® Dell Printers® Additional Color Laser Software® Status Monitor Console. The Printer Selection dialog box opens.
2. Click Dell Color Laser 1320c listed in Printer Name. The Dell Color Laser 1320c Launcher window opens.
3. Click the Tool Box button. The Tool Box opens. You can also launch the Tool Box from the printer icon on the taskbar.
4. Click the Printer Maintenance tab.
5. Select Reset Defaults from the list at the left side of the page. The Reset Defaults page is displayed.
6. Click Start to initialize the non-volatile memory (NVM) memory. The printer is turned off automatically to apply the settings.
Understanding Tool Box Menus

The Tool Box allows you to view or specify the printer settings. You can also diagnose the printer settings by using the Tool Box.

The Tool Box consists of the Printer Settings Report, Printer Maintenance, and Diagnosis tabs.

- **Printer Settings Report**
- **Printer Maintenance**
- **Diagnosis**

**NOTE:** A Password dialog box appears the first time you try to change settings or click a button after starting up the Tool Box. Input the password you specified in Set Password in the Printer Maintenance tab. The default password is left blank. You can click OK without entering a password to go to the next step.

### Printer Settings Report

The Printer Settings Report tab includes the Printer Information, Menu Settings, Reports, and TCP/IP Settings pages.

**NOTE:** Values marked by an asterisk (*) are the factory default menu settings.

#### Printer Information

**Purpose:**

To verify the printer details such as hardware configuration and software version.

**Values:**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dell Service Tag Number</td>
<td>Displays Dell’s service tag number.</td>
</tr>
<tr>
<td>Printer Serial Number</td>
<td>Displays the printer’s serial number.</td>
</tr>
<tr>
<td>Printer Type</td>
<td>Displays the type of printing for the printer. Color Laser is displayed normally.</td>
</tr>
<tr>
<td>Asset Tag Number</td>
<td>Displays the printer’s asset tag number.</td>
</tr>
<tr>
<td>Memory Capacity</td>
<td>Displays the memory capacity.</td>
</tr>
<tr>
<td>Processor Speed</td>
<td>Displays the processing speed.</td>
</tr>
<tr>
<td>Firmware Version</td>
<td>Displays the version of the controller.</td>
</tr>
<tr>
<td>Network Firmware Version</td>
<td>Displays the NIC version.</td>
</tr>
<tr>
<td>MCU Firmware Version</td>
<td>Displays the version of the MCU firmware.</td>
</tr>
<tr>
<td>Printing Speed (Color)</td>
<td>Displays the speed for color printing.</td>
</tr>
<tr>
<td>Printing Speed (Monochrome)</td>
<td>Displays the speed for monochrome printing.</td>
</tr>
</tbody>
</table>

#### Menu Settings

**Purpose:**

To display the current settings of the printer.
### Values:

<table>
<thead>
<tr>
<th>System Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power Saver Timer Mode 1</td>
<td>Displays the amount of time before the printer enters the Power Saver Timer Mode 1 (sleep mode) after a print job is complete.</td>
</tr>
<tr>
<td>Power Saver Timer Mode 2</td>
<td>Displays the amount of time before the printer enters the Power Saver Timer Mode 2 (deep sleep mode) when the times specified in Power Saver Timer Mode 1 and Power Saver Timer Mode 2 elapses after a print job is complete.</td>
</tr>
<tr>
<td>Control Panel Tone</td>
<td>Display whether the printer sounds the panel tone when you touch the panel.</td>
</tr>
<tr>
<td>Machine Ready Tone</td>
<td>Displays whether the printer sounds the tone when the printer is ready.</td>
</tr>
<tr>
<td>Job Complete Tone</td>
<td>Displays whether the printer sounds the tone when printing is complete.</td>
</tr>
<tr>
<td>Fault Tone</td>
<td>Displays whether the printer sounds the tone when an error occurs.</td>
</tr>
<tr>
<td>Alert Tone</td>
<td>Displays whether the printer sounds an alarm.</td>
</tr>
<tr>
<td>Out of Paper Alert Tone</td>
<td>Displays whether the printer sounds the tone when the printer runs out of paper.</td>
</tr>
<tr>
<td>Low Toner Alert Tone</td>
<td>Displays whether the printer sounds the tone when the toner is low.</td>
</tr>
<tr>
<td>Time-Out</td>
<td>Displays the amount of time the printer waits to receive additional bytes of data from the computer.</td>
</tr>
<tr>
<td>Device Language</td>
<td>Displays the language to be used for E-mail Alert.</td>
</tr>
<tr>
<td>Auto Log Print</td>
<td>Displays whether the printer outputs logs automatically.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Paper Density</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain</td>
<td>Displays the paper density for the plain paper.</td>
</tr>
<tr>
<td>Label</td>
<td>Displays the paper density for the label.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Adjust BTR</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain</td>
<td>Displays the voltage settings of the transfer roller (-6-6) for plain paper. The default is 0.</td>
</tr>
<tr>
<td>Plain Thick</td>
<td>Displays the voltage settings of the transfer roller (-6-6) for thick plain paper. The default is 0.</td>
</tr>
<tr>
<td>Covers</td>
<td>Displays the voltage settings of the transfer roller (-6-6) for cover paper. The default is 0.</td>
</tr>
<tr>
<td>Covers Thick</td>
<td>Displays the voltage settings of the transfer roller (-6-6) for thick cover paper. The default is 0.</td>
</tr>
<tr>
<td>Label</td>
<td>Displays the voltage settings of the transfer roller (-6-6) for labels. The default is 0.</td>
</tr>
<tr>
<td>Coated</td>
<td>Displays the voltage settings of the transfer roller (-6-6) for coated paper. The default is 0.</td>
</tr>
<tr>
<td>Coated Thick</td>
<td>Displays the voltage settings of the transfer roller (-6-6) for thick coated paper. The default is 0.</td>
</tr>
<tr>
<td>Envelope</td>
<td>Displays the voltage settings of the transfer roller (-6-6) for envelopes. The default is 0.</td>
</tr>
<tr>
<td>Recycled</td>
<td>Displays the voltage settings of the transfer roller (-6-6) for recycled paper. The default is 0.</td>
</tr>
<tr>
<td>Coated JPN</td>
<td>Displays the voltage settings of the transfer roller (-6-6) for Japanese coated paper. The default is 0.</td>
</tr>
<tr>
<td>Postcard JPN</td>
<td>Displays the voltage settings of the transfer roller (-6-6) for Japanese postcards. The default is 0.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Adjust Fuser</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain</td>
<td>Displays the temperature settings of the fuser (-2-2) for plain paper. The default is 0.</td>
</tr>
<tr>
<td>Plain Thick</td>
<td>Displays the temperature settings of the fuser (-2-2) for thick plain paper. The default is 0.</td>
</tr>
<tr>
<td>Covers</td>
<td>Displays the temperature settings of the fuser (-2-2) for cover paper. The default is 0.</td>
</tr>
<tr>
<td>Covers Thick</td>
<td>Displays the temperature settings of the fuser (-2-2) for thick cover paper. The default is 0.</td>
</tr>
<tr>
<td>Label</td>
<td>Displays the temperature settings of the fuser (-2-2) for labels. The default is 0.</td>
</tr>
<tr>
<td>Coated</td>
<td>Displays the temperature settings of the fuser (-2-2) for coated paper. The default is 0.</td>
</tr>
<tr>
<td>Coated Thick</td>
<td>Displays the temperature settings of the fuser (-2-2) for thick coated paper. The default is 0.</td>
</tr>
<tr>
<td>Envelope</td>
<td>Displays the temperature settings of the fuser (-2-2) for envelopes. The default is 0.</td>
</tr>
<tr>
<td>Recycled</td>
<td>Displays the temperature settings of the fuser (-2-2) for recycled paper. The default is 0.</td>
</tr>
<tr>
<td>Coated JPN</td>
<td>Displays the temperature settings of the fuser (-2-2) for Japanese coated paper. The default is 0.</td>
</tr>
<tr>
<td>Postcard JPN</td>
<td>Displays the temperature settings of the fuser (-2-2) for Japanese postcards. The default is 0.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Auto Registration Adjustment</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto Registration Adjustment</td>
<td>Displays whether to adjust the registration automatically.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Adjust Altitude</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adjust Altitude</td>
<td>Displays whether to adjust the height of the installation location of the printer.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Non-Dell Toner</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Non-Dell Toner</td>
<td>Displays whether to use a refilled toner cartridge.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Web Link Customization</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Reorder URL</td>
<td>Displays the URL (accessories.us.dell.com/sna).</td>
</tr>
<tr>
<td>Regular Premier</td>
<td>Displays the URL (premier.dell.com).</td>
</tr>
</tbody>
</table>
Purpose:

To print various types of reports and lists.

The reports are printed in the paper size specified in Printer Settings. The default is A4 or Letter.

Values:

<table>
<thead>
<tr>
<th>Printer Settings</th>
<th>Click the Start(1) button to print the printer settings page.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device Settings</td>
<td>Click the Start(2) button to print the detailed settings page.</td>
</tr>
<tr>
<td>Job History</td>
<td>Click the Start(3) button to print the job history report.</td>
</tr>
<tr>
<td>Error History</td>
<td>Click the Start(4) button to print the error history report.</td>
</tr>
<tr>
<td>Color Test Page</td>
<td>Click the Start(5) button to print the color test page.</td>
</tr>
</tbody>
</table>

TCP/IP Settings

Purpose:

To display the current settings of TCP/IP (Transmission Control Protocol/Internet Protocol) protocol.

Values:

<table>
<thead>
<tr>
<th>IP Address Mode</th>
<th>Displays the settings for the IP address.</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP Address</td>
<td>Displays the printer’s IP address.</td>
</tr>
<tr>
<td>Subnet Mask</td>
<td>Displays the subnet mask.</td>
</tr>
<tr>
<td>Gateway Address</td>
<td>Displays the gateway address.</td>
</tr>
</tbody>
</table>

Printer Maintenance

The Printer Maintenance tab includes the System Settings, Paper Density, Adjust BTR, Adjust Fuser, Registration Adjustment, Adjust Altitude, Reset Defaults, Non-Dell Toner, Initialize PrintMeter, Web Link Customization, TCP/IP Settings, EWS, and Set Password pages.

NOTE: Values marked by an asterisk (*) are the factory default menu settings.

System Settings

Purpose:

To configure the basic printer settings.

Values:

<table>
<thead>
<tr>
<th>Power Saver Timer Mode 1*1</th>
<th>1-30 min</th>
<th>Specifies the amount of time before the printer enters the Power Saver Timer Mode 1 (sleep mode) after a print job is complete.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>3 min*</td>
<td></td>
</tr>
</tbody>
</table>
Paper Density

Purpose:

To specify the paper density.
Adjust BTR

**NOTE:** The print quality changes depending on the setting values you select for this item.

**Purpose:**

To specify the reference voltage settings for the transfer roller.

<table>
<thead>
<tr>
<th>Values:</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain</td>
<td>Normal*</td>
</tr>
<tr>
<td>Label</td>
<td>Normal*</td>
</tr>
</tbody>
</table>

**Apply New Settings**

After you complete the settings, press the **Apply New Settings** button to apply the changes.

**Restart printer to apply new settings**

Press the **Restart printer to apply the new settings** button to apply the changes.

---

**Adjust Fuser**

**Purpose:**

---
To specify the temperature settings value for the fuser.

Values:

<table>
<thead>
<tr>
<th>Material</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain</td>
<td>-2-2</td>
<td>Sets the temperature settings for the fuser for plain paper.</td>
</tr>
<tr>
<td>Plain Thick</td>
<td>-2-2</td>
<td>Sets the temperature settings for the fuser for thick plain paper.</td>
</tr>
<tr>
<td>Covers</td>
<td>-2-2</td>
<td>Sets the temperature settings for the fuser for cover paper.</td>
</tr>
<tr>
<td>Covers Thick</td>
<td>-2-2</td>
<td>Sets the temperature settings for the fuser for thick cover paper.</td>
</tr>
<tr>
<td>Label</td>
<td>-2-2</td>
<td>Sets the temperature settings for the fuser for labels.</td>
</tr>
<tr>
<td>Coated</td>
<td>-2-2</td>
<td>Sets the temperature settings for the fuser for coated paper.</td>
</tr>
<tr>
<td>Coated Thick</td>
<td>-2-2</td>
<td>Sets the temperature settings for the fuser for thick coated paper.</td>
</tr>
<tr>
<td>Envelope</td>
<td>-2-2</td>
<td>Sets the temperature settings for the fuser for envelopes.</td>
</tr>
<tr>
<td>Recycled</td>
<td>-2-2</td>
<td>Sets the temperature settings for the fuser for recycled paper.</td>
</tr>
<tr>
<td>Coated JPN</td>
<td>-2-2</td>
<td>Sets the temperature settings for the fuser for Japanese coated paper.</td>
</tr>
<tr>
<td>Postcard JPN</td>
<td>-2-2</td>
<td>Sets the temperature settings for the fuser for Japanese postcards.</td>
</tr>
</tbody>
</table>

Apply New Settings
After you complete the settings, press the Apply New Settings button to apply the changes.

Restart printer to apply new settings
Press the Restart printer to apply the new settings button to apply the changes.

Registration Adjustment

Purpose:

To print the color registration chart and to adjust the color registration by using the chart. This function is required after the printer is set up or moved.

Values:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto Registration Adjustment</td>
<td>Off</td>
<td>Does not adjust the registration automatically.</td>
</tr>
<tr>
<td></td>
<td>On*</td>
<td>Adjusts the registration automatically.</td>
</tr>
<tr>
<td>Auto Correct</td>
<td></td>
<td>Click Start to adjust color registration automatically.</td>
</tr>
<tr>
<td>Color Regi Chart</td>
<td></td>
<td>Click Start to print the color registration chart.</td>
</tr>
<tr>
<td>Color Registration Adjustment 1 (Lateral)</td>
<td>Yellow</td>
<td>Specifies the values for the lateral direction that are found in the color registration chart.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Yellow: -9-9</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0*</td>
</tr>
<tr>
<td></td>
<td>Magenta</td>
<td>Specifies the values for the lateral direction that are found in the color registration chart.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Magenta: -9-9</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0*</td>
</tr>
<tr>
<td></td>
<td>Cyan</td>
<td>Specifies the values for the lateral direction that are found in the color registration chart.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Cyan: -9-9</td>
</tr>
<tr>
<td></td>
<td></td>
<td>0*</td>
</tr>
</tbody>
</table>
Adjust Altitude

Purpose:

To adjust the height of the location to install the printer.

Values:

<table>
<thead>
<tr>
<th>Altitude</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 meter*</td>
<td>Selects the value close to the height of the location to install the printer.</td>
</tr>
<tr>
<td>1000 meters</td>
<td></td>
</tr>
<tr>
<td>2000 meters</td>
<td></td>
</tr>
<tr>
<td>3000 meters</td>
<td></td>
</tr>
</tbody>
</table>

Apply New Settings

After you complete the settings, press the Apply New Settings button to apply the changes.

Restart printer to apply new settings

Press the Restart printer to apply the new settings button to apply the changes.

Reset Defaults

Purpose:

To initialize the non-volatile memory (NVM). After executing this function to automatically restart the printer, all the menu parameters are reset to their default values.

Values:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reset Defaults and restart printer.</td>
<td>Click Start to initialize the non-volatile memory (NVM) memory.</td>
</tr>
</tbody>
</table>

Non-Dell Toner

When Non-Dell toner is used, the printer may be severely damaged and may not be covered by your warranty.

Purpose:

To specify whether to use the refilled toner cartridge or not. When this setting is on, you can use toner cartridges provided by other companies.

Values:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Non-Dell Dell Toner</td>
<td>When Non-Dell toner is used, the printer may be severely damaged and may not be covered by your warranty.</td>
</tr>
</tbody>
</table>
**Initialize PrintMeter**

**Purpose:**

To initialize the data for the print meter. After executing this function to automatically restart the printer, the value of the meter resets to 0.

**Values:**

<table>
<thead>
<tr>
<th>Non-Dell Toner</th>
<th>Off*</th>
<th>Enables the use of refilled toner cartridges.</th>
</tr>
</thead>
<tbody>
<tr>
<td>On</td>
<td></td>
<td>Enables the use of refilled toner cartridges.</td>
</tr>
</tbody>
</table>

**Apply New Settings**

After you complete the settings, press the **Apply New Settings** button to apply the changes.

**Restart printer to apply new settings**

Press the **Restart printer to apply the new settings** button to apply the changes.

---

**Web Link Customization**

**Purpose:**

To configure the link used for ordering supplies.

**Values:**

<table>
<thead>
<tr>
<th>Select Reorder URL</th>
<th>Regular*</th>
<th>accessories.us.dell.com/sna</th>
</tr>
</thead>
<tbody>
<tr>
<td>Premier</td>
<td>premier.dell.com</td>
<td></td>
</tr>
</tbody>
</table>

**Apply New Settings**

After you complete the settings, press the **Apply New Settings** button to apply the changes.

**Restart printer to apply new settings**

Press the **Restart printer to apply the new settings** button to apply the changes.

---

**TCP/IP Settings**

**Purpose:**

To specify the TCP/IP settings for the network.

**Values:**

<table>
<thead>
<tr>
<th>IP Address Mode</th>
<th>AutoIP*</th>
<th>Automatically sets the IP address.</th>
</tr>
</thead>
<tbody>
<tr>
<td>DHCP</td>
<td></td>
<td>Uses DHCP to set the IP address.</td>
</tr>
<tr>
<td>BOOTP</td>
<td></td>
<td>Uses BOOTP to set the IP address.</td>
</tr>
<tr>
<td>RARP</td>
<td></td>
<td>Uses RARP to set the IP address.</td>
</tr>
<tr>
<td>Manually Set</td>
<td></td>
<td>Manually sets the IP address.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>IP Address</th>
<th>Sets the IP address allocated to the printer.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subnet Mask</td>
<td>Sets the subnet mask.</td>
</tr>
<tr>
<td>Gateway Address</td>
<td>Sets the gateway address.</td>
</tr>
</tbody>
</table>
**EWS (Embedded Web Server or Dell Printer Configuration Web Tool)**

**Purpose:**

To print the server settings for the Dell Printer Configuration Web Tool.

<table>
<thead>
<tr>
<th>Print Server Settings</th>
<th>Click Display to display the server settings for the Dell Printer Configuration Web Tool.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display of EWS</td>
<td>Off Disable to display the server settings for the Dell Printer Configuration Web Tool.</td>
</tr>
<tr>
<td></td>
<td>On* Enable to display the server settings for the Dell Printer Configuration Web Tool.</td>
</tr>
<tr>
<td>Apply New Settings</td>
<td>After you complete the settings, press the Apply New Settings button to apply the changes.</td>
</tr>
<tr>
<td>Restart printer to apply new settings</td>
<td>Press the Restart printer to apply the new settings button to apply the changes.</td>
</tr>
</tbody>
</table>

**Set Password**

**Purpose:**

To set a password to limit access to the menus.

**Values:**

| Setting of Panel Lock | Off* Does not set a password to limit access to the menus. |
|                       | On Set a password to limit access to the menus. |
| Password              | Type a new password. This must be between 0001 and 9999. |
| Input password again  | Type the new password again to confirm. |
| Apply New Settings    | After you complete the settings, press the Apply New Settings button, and then enter the user name and password to apply the changes. |
| Restart printer to apply new settings | Press the Restart printer to apply the new settings button to apply the changes. |

**Diagnosis**

The Diagnosis tab includes the Chart Print, Machine Check, Paper Wrinkle Check Mode, Environment Sensor Info, Developer Stir Mode, and Refresh Mode pages.

**NOTE:** Values marked by an asterisk (*) are the factory default menu settings.

**Chart Print**

**Purpose:**

To print the chart file.

**Values:**
Machine Check

Purpose:

To check the mechanical operations of the printer.

Values:

<table>
<thead>
<tr>
<th>Machine Check</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Main Motor Operation Check*</td>
<td>Checks the operation of the main motor.</td>
</tr>
<tr>
<td>Fuser Motor Operation Check</td>
<td>Checks the operation of the fuser motor.</td>
</tr>
<tr>
<td>Feed Roll Operation Check*</td>
<td>Checks the operation of the separator roller.</td>
</tr>
<tr>
<td>REGI CLUTCH Operation Check</td>
<td>Checks the operation of REGI CLUTCH.</td>
</tr>
<tr>
<td>Dispense Motor Check(Yellow)</td>
<td>Checks the operation of the dispense motor for each toner cartridge.</td>
</tr>
<tr>
<td>Dispense Motor Check(Magenta)</td>
<td></td>
</tr>
<tr>
<td>Dispense Motor Check(Cyan)</td>
<td></td>
</tr>
<tr>
<td>Dispense Motor Check(Black)</td>
<td></td>
</tr>
</tbody>
</table>

Play of Sound  Plays the sound the selected motor makes when it runs normally.

*1 When performing the feed roll operation check, remove the paper tray from the printer.

Paper Wrinkle Check Mode

Purpose:

To determine whether or not paper is wrinkled in the fuser.

This function stops printing before the paper enters the fuser. After you remove the paper inside the printer, check the following:

1. If the paper is wrinkled, the wrinkle occurred in the part other than fuser.
2. If the paper is not wrinkled, the wrinkle occurred in the fuser.

Values:

<table>
<thead>
<tr>
<th>Paper Size</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Letter*</td>
<td>Specifies the size of paper.</td>
</tr>
<tr>
<td>Legal</td>
<td></td>
</tr>
<tr>
<td>Envelope #10</td>
<td></td>
</tr>
<tr>
<td>8.5 x 13*</td>
<td></td>
</tr>
<tr>
<td>Executive</td>
<td></td>
</tr>
</tbody>
</table>
Environment Sensor Info

Purpose:

To display the information on the environment sensor in the printer by pressing the **Get Environment Sensor Info** button.

Developer Stir Mode

Purpose:

To stir the toner inside the toner cartridge.

Values:

- **Developer Stir Mode**: Click **Start** to stir the toner.

Refresh Mode
Purpose:

To clean the toner cartridges and PHD unit.

⚠️ **CAUTION:** Using the Refresh Mode consumes extra toner.

Values:

<table>
<thead>
<tr>
<th>Toner Refresh Mode</th>
<th>Color</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Yellow</td>
<td>Click <strong>Start (1)</strong> to clean the yellow cartridge.</td>
</tr>
<tr>
<td></td>
<td>Magenta</td>
<td>Click <strong>Start (2)</strong> to clean the magenta cartridge.</td>
</tr>
<tr>
<td></td>
<td>Cyan</td>
<td>Click <strong>Start (3)</strong> to clean the cyan cartridge.</td>
</tr>
<tr>
<td></td>
<td>Black</td>
<td>Click <strong>Start (4)</strong> to clean the black cartridge.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>PHD Refresh Mode</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>PHD</td>
<td>Click <strong>Start (5)</strong> to clean the PHD unit.</td>
</tr>
</tbody>
</table>
Understanding Your Printer Software

Printer Settings Utility

Use the Drivers and Utilities CD that shipped with your printer to install a combination of software programs, depending on your operating system.

Printing Status Window

The Printing Status Window alerts you when an error or warning occurs, for example, when a paper jam occurs or toner is running low.

The Printing Status Window always launches when printing. When an error occurs, the error message appears on the Printing Status Window.

You can also check toner level, quantity of paper remaining or the configuration of options for the local printer.

Status Monitor Console

Use the Status Monitor Console to manage multiple Status Window.

- Select a printer from the list view (or Printer Selection) by clicking its name to open a Status Window or Dell Printer Configuration Web Tool for a particular printer.
- The Status Monitor Console displays the Status Window for local connections, or the Dell Printer Configuration Web Tool for network connections.

Dell Supplies Management System™

You can launch the Dell Supplies Management System dialog box from the Printing Status window, the All Programs menu, or the desktop icon. You can also launch it from the Status Window when a toner error occurs.

You can order consumables by phone or from the web.

1. Click Start -> All Programs -> Dell Printers -> Additional Color Laser Software -> Dell Supplies Management System.
   The Dell Supplies Management System window appears.
2. Select your printer from the Select Printer Model list.
3. If you are ordering from the Web:
   a. When you cannot get information from the printer automatically by two-way communication, a window that prompts you to type the Service Tag number appears. Type your Dell printer Service Tag number in the field provided.
   b. Your Service Tag number is located inside the side cover of your printer.
4. If ordering by phone, call the number that appears under the By Telephone heading.

User Setup Disk Creating Tool

The User Setup Disk Creating Tool program located in the MakeDisk folder of the Utilities folder on the Drivers and Utilities CD and the printer drivers located on the Drivers and Utilities CD are used to create driver installation packages that contain custom driver settings. A driver installation package can contain a group of saved printer driver settings and other data for things such as:

- Print orientation and Multiple Up (document settings)
- Watermarks
- Font references
If you want to install the printer driver with the same settings to multiple computers running the same operating system, create a setup disk in a floppy disk or in a server on the network. Using the setup disk that you have created will reduce the amount of work required when installing the printer driver.

- Install in advance the Dell™ Color Laser Printer 1320c printer driver in the computer on which the setup disk is to be created.

- The setup disk can only be used on the operating system on which the disk was created or computers running the same operating system. Create a separate setup disk for different types of operating systems.

Software Update

The firmware and/or driver updates can be downloaded from the Dell Support website located at support.dell.com.

Printer Settings Utility

Using the Dell Color Laser 1320c Launcher window, you can open Printing Status Window, Tool Box, Updater, and Troubleshooting.

When you install the Dell software, the Dell Color Laser 1320c Launcher is automatically installed.

For information about installing the software, see "Setting Up for Shared Printing." 

To open the Dell Color Laser 1320c Launcher window:

1. Click Start ® All Programs ® Dell Printers ® Additional Color Laser Software ® Status Monitor Console.
The Printer Selection dialog box opens.

2. Click Dell Color Laser 1320c listed in Printer Name.
The Dell Color Laser 1320c Launcher window opens.

You can also launch the Dell Color Laser 1320c Launcher window from the printer icon on the taskbar.

3. The Dell Color Laser 1320c Launcher window provides four buttons; Status Window, Tool Box, Updater, and Troubleshooting.

To exit, click the X button at the top-right of the window.

For details, click the Help button of each application.

Status Window

The Status Window button opens the Printing Status Window. See "Printing Status Window."

Tool Box

You can use the Tool Box to specify various settings for the printer. See "Understanding Tool Box Menus"
The **Updater** button updates the settings for the print driver.

**Troubleshooting**

The **Troubleshooting** button opens the Troubleshooting Guide, which allows you to recover printer problems by yourself.
Tips for Successful Printing

Tips on Storing Print Media

Store your print media properly. For more information, see "Storing Print Media".

Avoiding Paper Jams

NOTE: Dell recommends that you try a limited sample of any print media you are considering using with the printer before purchasing large quantities.

By selecting appropriate print media and loading it properly, you can avoid paper jams. See the following instructions on loading print media:

1. "Loading Print Media in Tray 1"
2. "Loading the Single Sheet Feeder"
3. "Avoiding Jams"

If you experience a jam, see "Clearing Jams" for instructions.

Sending a Job to Print

To support all of the printer features, use the printer driver. When you choose Print from a software program, a window representing the printer driver opens. Select the appropriate settings for the specific job you are sending to print. Print settings selected from the driver override the default menu settings selected from the Tool Box.

You may need to click Preferences from the initial Print box to see all of the available system settings you can change. If you are not familiar with a feature in the printer driver window, open the online Help for more information.

To print a job from a typical Windows® application:

1. Open the file you want to print.
2. From the File menu, select Print.
3. Verify that the correct printer is selected in the dialog box. Modify the system settings as appropriate (such as the pages you want to print or the number of copies).
4. Click Preferences to adjust system settings not available from the first screen, and then click OK.
5. Click OK or Print to send the job to the selected printer.

Canceling a Print Job
There are several methods for canceling a print job.

**Canceling From the Printer Operator Panel**

To cancel a print job after it has started printing:

1. Press **Cancel**.
   
   Printing is canceled only for the current print job. All the following print jobs will continue to print.

**Canceling a Job From the Computer Running Windows**

**Canceling a Job From the Taskbar**

When you send a job to print, a small printer icon appears in the right corner of the taskbar.

1. Double-click the printer icon.
   
   A list of print jobs appears in the printer window.

2. Select the job you want to cancel.

3. Press **Delete** on the keyboard.

**Canceling a Job From the Desktop**

1. Click **Start** ➔ **Printers and Faxes**.
   
   For Windows 2000: Click **Start** ➔ **Settings** ➔ **Printers**.
   
   For Windows Server® 2003: Click **Start** ➔ **Printers and Faxes**.
   
   For Windows Vista®: Click **Start** ➔ **Control Panel** ➔ **Hardware and Sound** ➔ **Printers**.
   
   For Windows Server 2008: Click **Start** ➔ **Control Panel** ➔ **Printers**.
   
   A list of available printers appears.

2. Double-click the printer that you selected when you sent the job for print.
   
   A list of print jobs appears in the printer window.

3. Select the job you want to cancel.

4. Press **Delete** on the keyboard.

---

**Printing a Report Page**

By using the **Reports** menu, you can print a variety of settings for your printer including system settings, device setting, and job history. The following describes an example of printing from the **Reports** menu.

**Printing a Printer Settings Page**

To verify the detailed system settings, print a printer settings page.

See "Understanding Tool Box Menus" to identify the display if you need help.

1. Click **Start** ➔ **All Programs** ➔ **Dell Printers** ➔ **Additional Color Laser Software** ➔ **Status Monitor Console**. The **Printer Selection** dialog box opens.
2. Click **Dell Color Laser 1320c** listed in Printer Name.
   
   The **Dell Color Laser 1320c Launcher** window opens.
3. Click the **Tool Box** button. The **Tool Box** opens.
   
   You can also launch the Tool Box from the printer icon on the taskbar.
4. Click the **Printer Settings Report** tab.
5. Select **Reports** from the list at the left side of the page.
   
   The Reports page is displayed.
6. Click the **Start** button for Printer Settings.
   
   The Printer Settings page is printed.
You can also print the printer settings page by the following.

1. Press and hold the Continue button on the printer until the Ready/Data indicator blinks.

**NOTE:** You cannot print a printer settings page by pressing and holding the Continue button if the password is specified in Set Password of the Tool Box (because the operator panel is locked).

If any other message appears when you print this page, see the online Help for more information.
Setting Up for Shared Printing

You can share your new printer on the network using the Drivers and Utilities CD that shipped with your printer, or using Microsoft® point and print or peer-to-peer method. However, if you use one of the Microsoft methods, you will not have all the features, such as the status monitor and other printer utilities, that are installed with the Drivers and Utilities CD.

To share a locally-attached printer on the network, you need to share the printer, and then install the shared printer on network clients:


2. Right-click this printer icon and select Properties.
3. From the Sharing tab, check the Share this printer (Share as for Windows 2000) check box, and then type a name in the Share name (Share as for Windows 2000) text box.
4. Click Additional Drivers and select the operating systems of all network clients printing to this printer.
5. Click OK. If you are missing files, you will be prompted to insert the server operating system CD.

**For Windows Vista®:**

1. Click Start ➔ Control Panel.
2. Select Printer.
3. Right-click this printer icon and select Sharing.
4. Click Change sharing options button.
5. The dialog box displaying "Windows needs your permission to continue" appears.
6. Click Continue button.
7. Check the Share this printer check box, and then type a name in the Share name text box.
8. Click Additional Drivers and select the operating systems of all network clients printing to this printer.
9. Click OK.

**For Windows Server® 2008:**

1. Click Start ➔ Control Panel ➔ Printers.
2. Right-click the printer icon and select Sharing.
3. Check the Share this printer check box, and then type a name in the Share name text box.
4. Click Additional Drivers and select the operating systems of all network clients printing to this printer.
5. Click OK.

To check that the printer is successfully shared:

- Ensure that the printer object in the Printers and Faxes (Printers for Windows 2000) folder is shared. For example, in Windows 2000, a hand is shown underneath the printer icon.
- Browse My Network Places. Find the host name of the server and look for the shared name you assigned to the printer.

Now that the printer is shared, you can install the printer on network clients using the point and print method or the peer-to-peer method.
This method is usually the best use of system resources. The server handles driver modifications and print job processing. This lets network clients return to their programs much faster.

If you use the point and print method, a subset of driver information is copied from the server to the client computer. This is just enough information to send a print job to the printer.


1. On the Windows desktop of the client computer, double-click **My Network Places**.
2. Locate the host name of the server computer, and then double-click the host name.
3. Right-click the shared printer name, and then click **Connect**.
   - Wait for the driver information to copy from the server computer to the client computer, and for a new printer object to be added to the **Printers and Faxes** folder. The copy time varies, based on network traffic and other factors.
   - Close **My Network Places**.
4. Print a test page to verify print installation.
5. Click **Start** ➔ **Settings** ➔ **Printers and Faxes (Printers for Windows 2000)**.
6. Select the printer you just created.
7. Click **File** ➔ **Properties**.
8. From the **General** tab, click **Print Test Page**.
   - When a test page prints successfully, printer installation is complete.

**For Windows Vista® and Windows Server 2008:**

1. On the Windows desktop of the client computer, click **Start** ➔ **Network**.
2. Locate the host name of the server computer, and then double-click the host name.
3. Right-click the shared printer name, and then click **Connect**.
4. Click **Install driver**.
5. Click **Continue in User Account Control** dialog.
6. Wait for the driver information to copy from the server computer to the client computer, and for a new printer object to be added to the **Printers** folder. The time this takes varies, based on network traffic and other factors.
7. Print a test page to verify print installation.
8. Click **Start** ➔ **Control Panel**.
9. Select **Printer**.
10. Right-click the printer you just created and select **Properties**.
11. From the **General** tab, click **Print Test Page**.
   - When a test page prints successfully, printer installation is complete.

**Peer-to-Peer**

If you use the peer-to-peer method, the printer driver is fully installed on each client computer. Network clients retain control of driver modifications. The client computer handles the print job processing.


1. Click **Start** ➔ **Settings** ➔ **Printers and Faxes (Printers for Windows 2000)**.
2. Click **Add Printer** to launch the **Add Printer** wizard.
3. Click **Next**.
4. Select a network printer, or a printer attached to another computer, and then click Next (For Windows 2000, select the network printer from the Shared printers list). If the printer is not listed, type in the path of the printer in the text box.
   - For example: `\\server host name\\shared printer name`.
   - The server host name is the name of the server computer that identifies it to the network. The shared printer name is the name assigned during the server installation process.
5. Click **Browse for a printer**, and then click **Yes** (For Windows 2000, click **OK**).
   - If this is a new printer, you may be prompted to install a printer driver. If no system driver is available, then you will need to provide a path to available drivers.
6. Select whether you want this printer to be the default printer for the client, click **Next**, and then click **Finish** (For Windows 2000, click **Finish**).
7. Print a test page to verify printer installation:
   a. Click **Start** ➔ **Settings** ➔ **Printers and Faxes (Printers for Windows 2000)**.
b. Select the printer you just created.

c. Click File » Properties.

d. From the General tab, click Print Test Page. When a test page prints successfully, printer installation is complete.

For Window Vista® and Windows Server 2008:

1. Click Start » Control Panel » Hardware and Sound » Printers (Start » Control Panel » Printers for Windows Server 2008).

2. Click Add a Printer to launch the Add Printer wizard.

3. Select Add a network, wireless or Bluetooth printer, and then click Next. If the printer is listed, select the printer and click Next, or select The printer that I want isn't listed and type in the path of the printer in the Select a shared printer by name text box and click Next.

   The server host name is the name of the server computer that identifies it to the network. The shared printer name is the name assigned during the server installation process.

4. If this is a new printer, you may be prompted to install a printer driver. If no system driver is available, then you will need to provide a path to available drivers.

5. Select whether you want this printer to be the default printer for the client, click Next.

6. If you want to verify printer installation then click Print a test page.

7. Click Finish.

back to contents page
Clearing Jams

Careful selection of appropriate print media and proper loading allow you to avoid most jams. See “Print Media Guidelines” for more information.

- Avoiding Jams
- Identifying the Location of Paper Jams
- Clearing Paper Jams From the Single Sheet Feeder
- Clearing Paper Jams From the Tray 1
- Clearing Paper Jams From the Fuser

**NOTE:** Before buying large quantities of any print media, Dell recommends trying a sample first.

## Avoiding Jams

- Use only recommended print media. See “Print Media Guidelines” for more information.
- See “Loading Print Media in Tray 1” and “Loading the Single Sheet Feeder” to load printer media properly.
- Do not overload the print media sources. Ensure that the stack print media height does not exceed the maximum height indicated by the load line labels in the tray.
- Do not load wrinkled, creased, damp, or curled print media.
- Flex, fan, and straighten print media before you load it. If a jam occurs with print media, try feeding one sheet at a time through the single sheet feeder.
- Do not use print media that you have cut or trimmed yourself.
- Do not mix print media sizes, weights, or types in the same print media source.
- Ensure that the recommended print side is face up when you insert the print media. Also, the recommended print side should be face down when using the single sheet feeder.
- Keep print media stored in an acceptable environment. For more information, see “Storing Print Media.”
- Do not remove the feeding tray during a print job.
- Push the tray firmly after loading.
- Ensure that all cables that connect to the printer are correctly attached.
- Overtightening the guides may cause jams.
- Wipe the separator rollers in the tray or single sheet feeder with a cloth that is slightly dampened with water if jams caused by misfeeding paper occur frequently.

## Identifying the Location of Paper Jams

The following illustration shows where paper jams may occur along the print media path.
Clearing Paper Jams From the Single Sheet Feeder

**CAUTION:** Do not attempt to clear any jams using tools or instruments. This may permanently damage the printer.

<table>
<thead>
<tr>
<th>1</th>
<th>Front cover</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Tray 1</td>
</tr>
<tr>
<td>3</td>
<td>Single sheet feeder</td>
</tr>
<tr>
<td>4</td>
<td>Fuser</td>
</tr>
</tbody>
</table>

**NOTICE:** To protect the drums of the toner cartridges against bright light, close the front cover within three minutes. If the front cover remains open for more than three minutes, print quality may deteriorate.

**NOTE:** To resolve the error displayed on the operator panel, you must clear all print media from the print media path.

1. Pull the jammed paper out of the single sheet feeder. If no jammed paper can be found or it is hard to remove the paper, go to the next step to remove the jammed paper from the inside of the printer.

2. Remove the tray 1 from the printer, and then pull out the jammed paper remaining inside the printer. If no jammed paper can be found or it is hard to remove the paper, go to the next step to remove the jammed paper from the inside of the printer.

3. Open the front cover by pushing the button (right side) and remove the jammed paper. Then, confirm that there are no scraps of paper remaining inside the printer.
4. Close the front cover.
5. Insert the tray back into the printer, and push until it stops.

---

**Clearing Paper Jams From the Tray 1**

- **NOTICE:** To protect the drums of the toner cartridges against bright light, close the front cover within three minutes. If the front cover remains open for more than three minutes, print quality may deteriorate.
- **NOTE:** To resolve the error displayed on the operator panel, you must clear all print media from the print media path.

1. Pull the tray out of the printer carefully. Hold the tray with both hands, lift the front slightly, and remove it from the printer.

2. Remove all the jammed and/or creased paper from the tray.

3. Pull the jammed paper out carefully to avoid tearing it. If it is still hard to remove the paper, go to the next step to remove the jammed paper from the inside of the printer.
4. Open the front cover by pushing the button (right side) and remove the jammed paper. Then, confirm that there are no scraps of paper remaining inside the printer.

5. Close the front cover.

6. Insert the tray into the printer, and push until it stops.

⚠️ **CAUTION:** Do not use excessive force on the tray. Doing so could damage the tray or the inside of the printer.

---

### Clearing Paper Jams From the Fuser

⚠️ **NOTICE:** Ensure nothing touches or scratches the surface (black-colored film) of the belt unit. Scratches, dirt, or oil from your hands on the film of the belt unit may reduce print quality.

⚠️ **NOTICE:** To protect the drums of the toner cartridges against bright light, close the front cover within three minutes. If the front cover remains open for more than three minutes, print quality may deteriorate.

⚠️ **NOTE:** To resolve the error displayed on the operator panel, you must clear all print media from the print media path.

1. Turn off the printer and wait for 30 minutes.
2. Push the button (right side) and open the front cover.

3. Lift the levers at both ends of the fuser, and remove the jammed paper. If any jammed paper cannot be found, go to the next step.
4. Open the cover of the fuser and remove the jammed paper.
5. Close the cover of the fuser and press down the levers at both ends of the fuser.
6. Confirm that there are no scraps of paper remaining inside the printer, and then close the front cover.

⚠️ **CAUTION:** The fuser is hot. Do not touch it, doing so may cause burns.
Troubleshooting Guide

Basic Printer Problems

Some printer problems can be easy to resolve. If a problem occurs with your printer, check each of the following:

- The printer power cable is plugged into the printer and a properly grounded electrical outlet.
- The printer power is on.
- The electrical outlet is not turned off at any switch or breaker.
- Other electrical equipment plugged into the outlet are working.
- If you have checked all of the above and still have a problem, turn off the printer, wait for 10 seconds, and then turn on the printer. This often fixes the problem.

Printing Problems

<table>
<thead>
<tr>
<th>Problem</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Job did not print or incorrect characters printed.</td>
<td>Ensure print media is loaded in the printer.</td>
</tr>
<tr>
<td></td>
<td>Verify the printer is using the correct page description language (PDL).</td>
</tr>
<tr>
<td></td>
<td>Ensure you are using the correct Ethernet, or USB cable and that it is securely connected to the printer.</td>
</tr>
<tr>
<td></td>
<td>Verify that the correct print media size is selected.</td>
</tr>
<tr>
<td></td>
<td>If using a print spooler, verify that the spooler has not stalled.</td>
</tr>
<tr>
<td></td>
<td>Check the printer interface from the Tool Box menu.</td>
</tr>
<tr>
<td></td>
<td>Determine the host interface you are using. Print a Device Settings page to verify that the current interface settings are correct.</td>
</tr>
<tr>
<td>Print media misfeeds or multiple feeds occur.</td>
<td>Ensure the print media you are using meets the specifications for your printer. See &quot;Print Media Supported&quot; for more information.</td>
</tr>
<tr>
<td></td>
<td>Flex print media before loading it in any of the sources.</td>
</tr>
<tr>
<td></td>
<td>Ensure the print media is loaded correctly.</td>
</tr>
<tr>
<td></td>
<td>Ensure the width and length guides on the print media sources are adjusted correctly.</td>
</tr>
</tbody>
</table>
## Print Quality Problems

### Print is too light.

<table>
<thead>
<tr>
<th>Issue</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print is too light</td>
<td>Ensure the Tray 1 is securely inserted.</td>
</tr>
<tr>
<td>All of the print is too light.</td>
<td>Do not overfill the print media sources.</td>
</tr>
<tr>
<td>Part of the print is too light.</td>
<td>Do not force print media into the single sheet feeder when you load it; otherwise, it may skew or buckle.</td>
</tr>
<tr>
<td>The envelope is creased after printing.</td>
<td>Remove any curled print media from sources.</td>
</tr>
<tr>
<td>Print media does not stack neatly in the output bin.</td>
<td>Load the recommended print side correctly for the type of print media you are using.</td>
</tr>
<tr>
<td>The envelope is creased after printing.</td>
<td>See &quot;Loading Print Media in Tray 1&quot; for more information.</td>
</tr>
<tr>
<td>Page breaks in unexpected places.</td>
<td>Turn the print media over or around and try printing again to see if feeding improves.</td>
</tr>
<tr>
<td>Printer does not duplex pages.</td>
<td>Do not mix print media types.</td>
</tr>
<tr>
<td>Paper is curled in Tray 1.</td>
<td>Do not mix reams of print media.</td>
</tr>
<tr>
<td>The envelope is creased after printing.</td>
<td>Remove the top and bottom curled sheets of a ream before loading the print media.</td>
</tr>
<tr>
<td>Is part or all of the print too light?</td>
<td>Load a print media source only when it is empty.</td>
</tr>
<tr>
<td>All of the print is too light.</td>
<td>Wipe the separator rollers in the tray or single sheet feeder with a cloth that slightly dampened with water.</td>
</tr>
</tbody>
</table>

### All of the print is too light.

- The toner cartridges may be low or need to be replaced. Confirm the amount of toner in each toner cartridge.
  1. Press [Printer Status], and then click the Status tab in the Dell Printer Configuration Web Tool.
Part of the print is too light.

When you are printing many images with low density, do the Toner Refresh Mode.
1. Click the Tool Box button.
2. Press the Start button to check the density of colors.
Toner smears or print comes off page.

If you are printing on an uneven print surface, change the paper type setting in the printer driver. For example, change the plain paper to thick.

1. Press [Printing Preferences], and then click the Paper Tray tab.

Verify that the correct print media is being used.

1. See "Print Media Sizes and Support."

Try the spare PHD unit, if possible.

1. Replace the PHD unit. See "Replacing the PHD (Print Head Device) Unit" and "Installing the PHD Unit."
2. After you replace the PHD unit, click the Tool Box button.
3. Press the Print with A4(3) or Print with Letter(C) button.

Is the problem recovered?

Yes. The PHD unit is old or damaged. Replace the PHD unit.

No. The PHD unit is old or damaged. Replace the PHD unit.

Try the spare fuser, if possible.

1. Replace the fuser. See "Removing the Used Fuser" and "Installing a New Fuser."
2. After you replace the fuser, print paper. "Printing" appears.

Is the problem recovered?

Yes. The fuser is old or damaged. Replace the fuser.

No. Contact Dell.

Contact Dell.

Toner spots appear on the page/printing is blurred.

If you are printing on an uneven print surface, change the paper type setting in the printer driver. For example, change the plain paper to thick.
Check the toner cartridges is installed correctly.

1. See "Installing the Toner Cartridges."

Ensure the PHD unit is installed correctly.

1. See "Replacing the PHD (Print Head Device) Unit" and "Installing the PHD Unit."

Try the spare PHD unit, if possible.

1. Replace the PHD unit. See "Replacing the PHD (Print Head Device) Unit" and "Installing the PHD Unit."
2. After you replace the PHD unit, click the Tool Box button.

Is the problem recovered?

Yes. The PHD unit is old or damaged. Replace the PHD unit.

No. Contact Dell.

Contact Dell.

Entire page is white.

The toner cartridges may be low or need to be replaced. Confirm the amount of toner in each toner cartridge.

1. Press [Printer Status], and then click the Status tab in the printer driver.

Ensure Non-Dell Toner is not selected in the Printer Maintenance tab in the Tool Box.

1. Click the Tool Box button.

Set Toner Saving Mode to Off in the printer driver.

1. Press [Printing Preferences], and then click the Advanced tab.

If you are printing on an uneven print surface, change the paper type setting in the printer driver. For example, change the plain paper to thick.

1. Press [Printing Preferences], and then click the Paper Tray tab.

Verify that the correct print media is being used.

1. See "Print Media Sizes and Support."

Ensure that eight yellow ribbons are correctly removed from the PHD unit.

1. See "Replacing the PHD (Print Head Device) Unit" and "Installing the PHD Unit."
## Streaks appear on the page.

The toner cartridges may be low or need to be replaced. Confirm the amount of toner in each toner cartridge.

1. Press [Printer Status], and then click the Status tab in the printer driver.

Ensure Non-Dell Toner is not selected in the Printer Maintenance tab in the Tool Box.

1. Click the Tool Box button.
2. Select Non-Dell Toner from the list.

Try the spare PHD unit, if possible.

1. Replace the PHD unit. See "Replacing the PHD (Print Head Device) Unit" and "Installing the PHD Unit".
2. After you replace the PHD unit, click the Tool Box button.
3. Press [Chart Print], and then press the Print with A4 (3) or Print with Letter(C) button.
   Is the problem recovered?

### Yes.
- The PHD unit is old or damaged. Replace the PHD unit.

### No.
- Contact Dell.

Contact Dell.

---

## Part or all of the page prints in black.

Ensure Color (Auto) is selected in Output Color on the
Pitched dots prints in color

Vertical blanks
Ensure the light path is not covered.

1. Remove the PHD unit, and keep in the dark place. See "Replacing the PHD (Print Head Device) Unit".
2. Check the light path, and then remove the shielding.
3. Reinstall the PHD unit. See "Installing the PHD Unit".
4. Click the Tool Box button.
5. Press the Print with A4(1) or Print with Letter(A) button. "Printing" appears. Is the problem recovered?

Yes. The task is complete.
No. Go to the next step.

Try the spare PHD unit, if possible.

1. Replace the PHD unit. See "Replacing the PHD (Print Head Device) Unit" and "Installing the PHD Unit".
2. After you replace the PHD unit, click the Tool Box button.
3. After you replace the PHD unit, press the Print with A4(1) or Print with Letter(A) button. "Printing" appears. Is the problem recovered?

Yes. The PHD unit is old or damaged. Replace the PHD unit.
No. Contact Dell.

Ghost

Locate the cause of the problem by using the Ghost Configuration Chart.

1. Click the Tool Box button.
2. Press the Print with A4(2), or Print with Letter(B) button. Do either of the following:

When the ghost is printed in positive, try the spare PHD unit, if possible.

1. See "Replacing the PHD (Print Head Device) Unit" and "Installing the PHD Unit".
2. After you replace the PHD unit, press [Chart Print], and then press the Print with A4(2), or Print with Letter(B) button. "Printing" appears. Is the problem recovered?

Yes. The PHD unit is old or damaged. Replace the PHD unit.
No. Contact Dell.
When the ghost is printed in negative, use the recommended paper.
Is the problem recovered?

Yes. The task is complete.
No. Do either of the following:

Try the spare PHD unit, if possible.

1. Replace the PHD unit. See "Replacing the PHD (Print Head Device) Unit" and "Installing the PHD Unit".
2. After you replace the PHD unit, click the Tool Box button, and then press the Print with A4(2), or Print with Letter(B) button. "Printing" appears. Is the problem recovered?

Yes. The PHD unit is old or damaged. Replace the PHD unit.
No. Contact Dell.

Adjust the transfer bias.

1. Click the Tool Box button.
2. Adjust the setting for the paper type, and then press
Light fatigue

Check the pattern for light fatigue.

1. Click the Tool Box button.
2. Press the Print with A4(1) or Print with Letter(A) button. "Printing" appears. Is the pattern matched?

Yes. Do the PHD Refresh Mode.

1. Click the Tool Box button.
2. After you start the PHD Refresh Mode, click the Tool Box button, and then press the Print with A4(3), or Print with Letter(C) button. "Printing" appears. Is the problem recovered?

Yes. The task is complete.
No. Replace the PHD unit. See "Replacing the PHD (Print Head Device) Unit" and "Installing the PHD Unit".
No. Contact Dell.

Fog

Do the PHD Refresh Mode.

1. Click the Tool Box button.
2. After you complete the Refresh Mode, select Chart Print from the list. Press the Print with A4 (3) or Print with Letter (C) button. "Printing" appears. Is the problem recovered?

Yes. The task is complete.
No. Replace the PHD unit, if possible. See "Replacing the PHD (Print Head Device) Unit" and "Installing the PHD Unit".
After you complete the Refresh Mode, select Chart Print from the list. Press the Print with A4 (3) or Print with Letter (C) button. "Printing" appears. Is the problem recovered?
Yes. The task is complete.
No. Contact Dell.

Bead-Carry-Out (BCO)
**Banding**

Do Adjust Altitude if you install the printer in a high altitude location.

1. Click the **Tool Box** button.
2. Selects the value close to the height of the location to install the printer.

**Is the problem recovered?**

Yes. The task is complete.

No. Replace the PHD unit, if possible. See "Replacing the PHD (Print Head Device) Unit" and "Installing the PHD Unit".

**Is the problem recovered?**

Yes. The PHD unit is old or damaged. Replace the PHD unit.

No. Contact Dell.

Locate the cause of the problem by using the Pitch Configuration Chart.

1. Click the **Tool Box** button.
2. Press Print with A4(1), or Print with Letter(A).
3. Do either of the following:

**The cause of the problem was located in the PHD unit.**

1. Replace the PHD unit. See "Replacing the PHD (Print Head Device) Unit" and "Installing the PHD Unit"
2. After you replace the PHD unit, press Print with A4(1), or Print with Letter(A). "Printing" appears.

**Is the problem recovered?**

Yes. The task is complete.

No. Contact Dell.

**The cause of the problem was located in the fuser.**

1. Replace the fuser. See "Removing the Used Fuser" and "Installing a New Fuser"
2. After you replace the fuser, press Print with A4(1), or Print with Letter(A). "Printing" appears.

**Is the problem recovered?**

Yes. The task is complete.

No. Contact Dell.

**The cause of the problem was located in the printer, or the cause was not determined.**

1. Contact Dell.
Auger mark

Is the error print match with the pattern for the auger mark?

Yes. Click the Tool Box button.

1. Press the Start button.
2. After you perform the Developer Stir Mode, click the Tool Box button, and then press Print with A4(1) or Print with Letter(A). "Printing" appears. Is the problem recovered?

Yes. The task is complete.

No. Replace the PHD unit. See "Replacing the PHD (Print Head Device) Unit" and "Installing the PHD Unit".

Abnormal noise

Locate the cause of the problem by removing the toner cartridges, fuser, and PHD unit.

1. Remove the toner cartridges, fuser, and PHD unit. See "Removing the Used Toner Cartridge", "Removing the Used Fuser", and "Replacing the PHD (Print Head Device) Unit".
2. Click the Tool Box button.
3. Press the Start button after selecting Main Motor Operation Check, Fuser Motor Operation Check, and Dispense Motor Check to identify the abnormal noise. Check if the noise from the Play of Sound button is matched with the abnormal noise.

1. Is the noise from Main Motor Operation Check matched?

Yes. Contact Dell.

No. Go to the next step.

2. Is the noise from Fuser Motor Operation Check matched?

Yes. Contact Dell.

No. Go to the next step.

3. Is the noise from Dispense Motor Check matched?

NOTE: Do not check the operation of the dispense motor repeatedly.

Yes. Contact Dell.

No. Replace the fuser. See "Removing the Used Fuser" and "Installing a New Fuser".

4. Is the noise from Fuser Motor Operation Check matched?

Yes. Contact Dell.

No. Replace the PHD unit. See "Replacing the PHD (Print Head Device) Unit" and "Installing the PHD Unit".
Jam/Alignment

The job prints, but the top and side margins are incorrect.
1. Ensure the margins are set correctly in your software program.

Color registration is out of alignment.
Do either of the following:
1. Click the Tool Box button.
2. Press the Start button for Color Regi Chart.
Is the problem recovered?
Yes. The task is complete.
No. Try the spare PHD unit, if possible.
1. Replace the PHD unit. See "Replacing the PHD (Print Head Device) Unit" and "Installing the PHD Unit".
2. After you replace the PHD unit, click the Tool Box button.
3. Press the Start button for Auto Correct.
   Is the color chart matched with the error paper?
Yes. The PHD unit is old or damaged. Replace the PHD unit. See "Replacing the PHD (Print Head Device) Unit" and "Installing the PHD Unit".
No. Press the Start button for Color Regi Chart.
Is the color chart matched with the error paper?
Yes. The task is complete.
No. Check the offset value shown in the printed chart, and then specify each value for Color Registration Adjustment 1 (Lateral) and Color Registration Adjustment 2 (Process) and then press the Start button for Color Regi Chart.
Is the color chart matched with the error paper?
Yes. The task is complete.
No. Contact Dell.

Contact Dell.

Misfeed jam
| Are the width and length guides on the print media sources adjusted correctly? | Yes.  
| Is the Tray 1 installed correctly? | Yes. Check the paper type.  
| Thick | Is thick paper 216 gsm or lower?  
| No. Use paper at 216 gsm or lower.  
| Is the problem recovered? | Yes. The task is complete.  
| No. Flex print media before loading it.  
| Thin | Is thin paper 60 gsm or more?  
| No. Use paper at 60 gsm or more.  
| Is the problem recovered? | Yes. The task is complete.  
| Coated | Load one sheet of coated paper at one time.  
| Is the problem recovered? | Yes. The task is complete.  
| Envelope | Is the envelope inserted with the flap closed and the short-edge of the envelope facing down from the single sheet feeder?  
| Yes. The envelope is curled.  
| 1. Straighten the curl.  
| Is the problem recovered? | Yes. The task is complete.  
| No. Flex print media before loading it.  
| No. Use the other envelope.  
| Is the problem recovered? | Yes. The task is complete.  
| No. Flex print media before loading it.  
| No. Face the short-edge of the envelope into the printer.  
| Transparency | Transparency cannot be used.  
| Manual Duplex | Is paper curled?  
| Yes. The paper is curled.  
| 1. Straighten the curl.  
| Is the problem recovered? | Yes. The task is complete.  
| No. Flex print media before loading it.  
| No. Flex print media before loading it.  
| Others | Is paper moistened?  
| Yes. Turn the paper upside down.  
| Is the problem recovered? | Yes. The task is complete.  
|
### Regi jam

Ensure the PHD unit is installed correctly.

1. Replace the PHD unit. See "Replacing the PHD (Print Head Device) Unit" and "Installing the PHD Unit".

   Is the problem recovered?
   - Yes. The task is complete.
   - No. Contact Dell.

### Exit Jam

Ensure the fuser is installed correctly.

1. Replace the fuser. See "Removing the Used Fuser" and "Installing a New Fuser".

   Is the problem recovered?
   - Yes. The task is complete.
   - No. Contact Dell.

### Multi-feed jam

<table>
<thead>
<tr>
<th>Is the toner cartridge installed correctly?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes. Check the paper type.</td>
</tr>
<tr>
<td>No. Replace the toner cartridge correctly. See &quot;Removing the Used Toner Cartridge&quot; and &quot;Installing a New Toner Cartridge&quot;.</td>
</tr>
<tr>
<td>Coated</td>
</tr>
<tr>
<td>Load one sheet of coated paper at one time.</td>
</tr>
<tr>
<td>Others</td>
</tr>
<tr>
<td>Is paper moisten?</td>
</tr>
<tr>
<td>Yes. Use the dry paper.</td>
</tr>
<tr>
<td>Is the problem recovered?</td>
</tr>
<tr>
<td>Yes. The task is complete.</td>
</tr>
<tr>
<td>No. Flex print media before loading it.</td>
</tr>
<tr>
<td>No. Flex print media before loading it.</td>
</tr>
<tr>
<td>Is the problem recovered?</td>
</tr>
<tr>
<td>Yes. The task is complete.</td>
</tr>
<tr>
<td>No. Wipe the separator rollers in the tray with a cloth that slightly dampened with water.</td>
</tr>
</tbody>
</table>
Creased/stained paper

Verify that the correct print media is being used.

1. See "Print Media Sizes and Support".

If you use paper that Dell does not recommend, use the standard paper.

Is the problem recovered?

Yes. Use the other type of paper because your printer does not support the paper you use.

No. Go to the next step.

1. See "Print Media Sizes and Support".

If you use paper that Dell does not recommend, use the standard paper, and do the Paper Wrinkle Check Mode.

1. Click the Tool Box button.
2. Press the Start button.

Is the paper wrinkled?

Yes. Contact Dell.
No. Replace the fuser.

If you use an enveloper that Dell does not recommend, use the standard envelope.

Is the problem recovered?

Yes. The task is complete.

No. Check the crease. Is the crease found within 30 mm of the four edges of the envelope?

Yes. This type of crease may be caused by the normal operation.

No. Is the envelope 220 mm long or more?

Yes. (The type of your envelope is C5, ChKei3, COM·10, YoKei4, or YochoKei.) Does the envelope have the flap on the long edge or short edge?

- Flap on the long edge (C5, or ChKei3).
  - Open the flap, and load the flap face down in Tray 1.
  Is the problem recovered?
  Yes. The task is complete.
  No. Use the other type of envelope.
  Is the problem recovered?
  Yes. The task is complete.
  No. Contact Dell.
  - Flap on the short edge (COM·10, YoKei4, or YochoKei).
  Use the other type of envelope.

No. Open the flap, and load the flap face down in Tray 1.
Is the problem recovered?

Yes. The task is complete.

No. Use the other type of envelope.
Is the problem recovered?

Yes. The task is complete.

No. Contact Dell.
Other Problems

<table>
<thead>
<tr>
<th>Problem</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Condensation has occurred inside the printer.</td>
<td>This usually occurs within several hours after you heat the room in winter. This also occurs when the printer is operating in a location where relative humidity reaches 85% or more. Adjust the humidity or relocate the printer to an appropriate environment.</td>
</tr>
<tr>
<td>&quot;092-310 Printer error.&quot; or &quot;092-910 Clean the CTD sensor.&quot; displayed on the Status Monitor.</td>
<td>Clean the CTD sensor. See &quot;Cleaning the CTD Sensor Inside the Printer.&quot;</td>
</tr>
</tbody>
</table>

Contacting Service

When you call for printer service, be prepared to describe the problem you are experiencing or the error message on the display.

You need to know your printer model type and serial number. See the label on the back of the printer near the controller card for this information.
Maintaining Your Printer

Periodically, your printer requires you to complete certain tasks to maintain optimum print quality. If several people are using the printer, you may want to designate a key operator to maintain your printer. Refer printing problems and maintenance tasks to this key operator.

- Determining the Status of Supplies
- Conserving Supplies
- Ordering Supplies
- Storing Print Media
- Storing Consumables
- Replacing Toner Cartridges
- Replacing the PHD (Print Head Device) Unit
- Replacing the Fuser
- Replacing Separator Roller
- Cleaning the CTD Sensor Inside the Printer
- Adjusting Color Registration

Determining the Status of Supplies

If your printer is connected to the network, the Dell™ Printer Configuration Web Tool (EWS) can provide instant feedback on remaining toner levels. Type the printer IP address in your Web browser to view this information. To use the E-Mail Alert Setup feature that notifies you when the printer requires new supplies, type your name or the name of the key operator in the e-mail list box.

Conserving Supplies

You can change several settings in your printer driver to conserve toner cartridge and paper.

<table>
<thead>
<tr>
<th>Supply</th>
<th>Setting</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Toner cartridge</td>
<td>Toner Saving Mode in the Advanced tab</td>
<td>This check box allows the users to select a print mode that uses less toner. When this feature is used, the image quality will be lower than when it is not used.</td>
</tr>
<tr>
<td>Print media</td>
<td>Multiple Up in the Print Setup tab</td>
<td>The printer prints two or more pages on one side of a sheet. Values for Multiple Up are 2 Up, 4 Up, 8 Up, 16 Up, or 32 Up. Combined with the duplex setting, Multiple Up allows you to print up to 64 pages on one sheet of paper. (32 images on the front and 32 on the back)</td>
</tr>
</tbody>
</table>

Ordering Supplies

You can order consumables from Dell on the Internet when using a networked printer. Type the IP address of your printer in your Web browser, launch the Dell Printer Configuration Web Tool, and click the Order Supplies at: to order toner for your printer.

You can also order toner cartridges by the following method.

1. Click Start → All Programs → Dell Printers → Additional Color Laser Software → Dell Supplies Management System.
   The Dell Supplies Management System window appears.
2. Select your printer from the Select Printer Model list.
3. If ordering from the Web:
   a. When you cannot get information from the printer automatically by two-way communication, a window that prompts you to type the Service Tag
number appears. Type your Dell printer Service Tag number in the field provided. Your Service Tag number is located inside the side cover of your printer.

b. Select a URL from the Select Reorder URL list.

c. Click Visit Dell printer supplies ordering web site.

4. If ordering by phone, call the number that appears under the By Telephone heading.

Storing Print Media

To avoid potential paper feeding problems and uneven print quality, there are several things you can do.

- To achieve the best possible print quality, store print media in an environment where the temperature is approximately 21°C (70°F) and the relative humidity is 40%.
- Store cartons of print media on a pallet or shelf, rather than directly on the floor.
- If you store individual packages of print media out of the original carton, ensure that they rest on a flat surface so the edges do not buckle or curl.
- Do not place anything on top of the print media packages.

Storing Consumables

Store consumables in their original packaging until you need to use them. Do not store consumables in:

- Temperatures greater than 40°C (104°F).
- An environment with extreme changes in humidity or temperature.
- Direct sunlight.
- Dusty places.
- A car for a long period of time.
- An environment where corrosive gases are present.
- An environment with salty air.

Replacing Toner Cartridges

⚠️ CAUTION: Before performing any of the following procedures, read and follow the safety instructions in your Product Information Guide.

주의: To protect the drums of the toner cartridges against bright light, close the front cover within three minutes. If the front cover remains open for more than three minutes, print quality may deteriorate.

Dell toner cartridges are available only through Dell. You can order more cartridges online at http://www.dell.com/supplies or by phone. To order by phone, see "Contacting Dell™" on page 215.

Dell recommends that you use Dell toner cartridges for your printer. Dell does not provide warranty coverage for problems caused by using accessories, parts, or components not supplied by Dell.

⚠️ CAUTION: Never throw used toner cartridges into fire. The residual toner could explode resulting in burns and injuries.

⚠️ CAUTION: Do not shake the used toner cartridge to avoid spilling of toner.

Removing the Used Toner Cartridge

1. Open the side cover.
2. Push the latch(es) backwards to pop open the toner cartridge(s) that you want to replace.

3. Pull the cartridge holder until it clicks, and then pull out the toner cartridge.

⚠️ **CAUTION:** Do not shake the toner cartridge as it may spill some toner.

### Installing a New Toner Cartridge

1. Ensure that the color of the new toner cartridge matches that on the handle before replacing it. Shake the toner cartridge five or six times to distribute the toner evenly.

2. Insert the toner cartridge into the associated cartridge holder, and slide the latches of the toner cartridge.
3. Close the side cover.

Replacing the PHD (Print Head Device) Unit

1. Ensure that the printer is turned off.
2. Press the button (right side) and open the front cover.
3. Turn the four PHD lock levers counterclockwise.
4. Pull the PHD unit out of the printer.
Installing the PHD Unit

1. Open the PHD packaging.

2. Pull out the PHD unit from the packaging.

3. Completely remove the eight yellow ribbons from the PHD unit.

4. Remove the rear protective cover from the PHD unit.
5. Insert the PHD unit until it is seated properly and turn the four PHD lock levers clockwise to lock the PHD unit.

6. Carefully remove the front protective cover from the PHD unit.

7. Close the front cover.

Replacing the Fuser

⚠️ CAUTION: A CAUTION indicates a potential for property damage, personal injury, or death.
⚠️ CAUTION: To prevent electric shock, always turn off the printer and disconnect the power cable from the grounded outlet before performing maintenance.
⚠️ CAUTION: Before performing any of the following procedures, read and follow the safety instructions in your Product Information Guide.
Dell recommends Dell fuser for your printer. Dell does not provide warranty coverage for problems caused by using accessories, parts, or components not supplied by Dell.

Removing the Used Fuser

⚠️ CAUTION: To avoid burns, do not replace the fuser immediately after printing, as the fuser gets very hot during this process.

1. Turn off the printer and wait for 30 minutes for the fuser to cool down before removal.
2. Push the button (right side) and open the front cover.
3. Press the button on the right side of the fuser.
4. By holding both sides of the installed fuser, slightly fix the left side of the fuser and turn the right edge towards the front of the printer.

Installing a New Fuser

1. Unpack a new fuser and hold both sides of the fuser with both hands.
2. Insert the left edge of the fuser to the wholes inside of the printer.
3. By turning the right side of the fuser towards the rear of printer, insert the right notch into the holder inside the printer.

4. Close the front cover.

---

**Replacing Separator Roller**

Keeping the separator roller in the paper tray clean helps ensure the best possible copies. Dell recommends cleaning the separator at regular intervals.

⚠️ **CAUTION:** To prevent electric shock, always turn off the printer and disconnect the power cable from the grounded outlet before performing maintenance.

⚠️ **CAUTION:** Before performing any of the following procedures, read and follow the safety instructions in your *Product Information Guide*. 
Dell separator rollers are available only through Dell. To order by phone, see "Contacting Dell™ on page 215.

Dell recommends Dell separator rollers for your printer. Dell does not provide warranty coverage for problems caused by using accessories, parts, or components not supplied by Dell.

**Removing the Used Separator Roller in the Tray 1**

1. Pull the Tray 1 out of the printer carefully. Hold the tray with both hands, lift the front slightly, and remove it from the printer.

2. By holding the separator roller tabs with your fingers, pull the separator roller out of the groove in the axle.

**Installing the New Separator Roller in the Tray**

1. Align the new separator roller to the groove on the axle.
2. Insert the separator roller into the axle till it snaps fit so the protrusions fit completely into the slots and the roller hook reseats into the groove on the axle.

3. Load paper and place it in the printer. Be sure to use the output tray extension before printing a Legal-size document.

**Cleaning the Separator Roller Inside the Printer**

Clean the separator roller inside the printer if print media does not feed correctly.

1. Ensure that the printer is turned off.
2. Push the button (right side) and open the front cover.

3. Turn the four PHD lock levers counterclockwise, and then pull the PHD unit out of the printer.
4. Clean the separator roller inside the printer with a clean dry cotton swab.

5. Insert the PHD unit until it stops and turn the four PHD lock levers clockwise to lock the PHD unit.

**NOTE:** Keep the PHD unit in the dark place.
Cleaning the CTD Sensor Inside the Printer

Clean the CTD sensor only when an alert for the CTD sensor is shown on the Status Monitor or operator panel.

1. Ensure that the printer is turned off.
2. Push the button (right side) and open the front cover.
3. Clean the CTD sensor inside the printer with a clean dry cotton swab.
4. Close the front cover.
Adjusting Color Registration

To adjust the color registration when you first install the printer or after moving it to a new location, follow the procedure below.

Printing the Color Registration Chart

Use the Tool Box to print the color registration chart.

1. Click Start ® All Programs ® Dell Printers ® Additional Color Laser Software ® Status Monitor Console. The Printer Selection dialog box opens.
2. Click Dell Color Laser 1320c listed in Printer Name. The Dell Color Laser 1320c Launcher window opens.
3. Click the Tool Box button. The Tool Box opens. You can also launch the Tool Box from the printer icon on the taskbar.
4. Click the Printer Maintenance tab.
5. Select Registration Adjustment from the list at the left side of the page. The Registration Adjustment page is displayed.
6. Click the Start button next to Color Regi Chart. The Color Regi Chart page is printed.

Determining Values

From the lines to the right of the Y (Yellow), M (Magenta), and C (Cyan) pattern, find the values of the straightest lines.

NOTE: You can also use the densest colors of the lattice pattern to find the straightest lines. The colors printed at the highest density are those next to the straightest lines. When 0 is the value nearest the straightest line, you do not need to adjust the color registration. When the value is not 0, follow the procedure outlined in “Entering Values”.

Entering Values

Using the Tool Box, enter the values that you found in the color registration chart to make adjustments.

1. Click Start ® All Programs ® Dell Printers ® Additional Color Laser Software ® Status Monitor Console. The Printer Selection dialog box opens.
2. Click Dell Color Laser 1320c listed in Printer Name. The Dell Color Laser 1320c Launcher window opens.
3. Click the Tool Box button. The Tool Box opens. You can also launch the Tool Box from the printer icon on the taskbar.
4. Click the Printer Maintenance tab.
5. Select Registration Adjustment from the list at the left side of the page. The Registration Adjustment page is displayed.
6. Select the value with the straight line, and then click the Apply New Settings button.
7. Click the Start button next to Color Regi Chart. The color registration chart is printed with the new values.
8. Adjust till all straight lines are at the value of 0. Show image of before and after adjustment will help.
CAUTION: After printing the color registration chart, do not turn off the printer until the printer motor has stopped running.

NOTE: If 0 is not next to the straightest lines, determine the values and adjust the printer again.
Printer Specifications

OS Compatibility


1 Dell technical phone support only supports factory-installed operating systems (Microsoft) for the first 30 days for free. See http://www1.us.dell.com/content/products/compare.aspx/laser?c=us&cs=555&l=en&s=biz for more details. The customer will have to purchase technical support from the manufacturer of the operating system in order to get technical assistance beyond 30 days.

2 If the customer has other operating systems and has purchased Gold Technical Support (for more information on Gold Technical Support, see http://www1.us.dell.com/content/topics/global.aspx/services/en/gts?c=us&cs=555&l=en&s=biz), the telephone support will be a "best effort" attempt to resolve the operating system issue. If the manufacturer needs to be contacted, the customer must pay an additional fee for that support. The only time that Dell pays for the third party support is when Dell is responsible for the issue. In the case of getting the printer installed and working, this is configuration and the customer would be responsible for paying.

Power Supply

<table>
<thead>
<tr>
<th></th>
<th>220-240 V AC</th>
<th>100-127 V AC</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rated Voltage</td>
<td>5 A</td>
<td>10 A</td>
</tr>
<tr>
<td>Frequency</td>
<td>50/60 Hz</td>
<td>50/60 Hz</td>
</tr>
</tbody>
</table>

Dimensions

Height: 378 mm (14.88 inches) Width: 400 mm (15.75 inches) Depth: 372 mm (14.65 inches) with the output tray closed (not including Tray 1 and cover cassette), 430 mm (16.9 inches) with the output tray extended

Weight (not including cartridge and PHD unit): 13.5 kg (30 lb)

Memory

<table>
<thead>
<tr>
<th></th>
<th>64 MB</th>
</tr>
</thead>
<tbody>
<tr>
<td>Base memory</td>
<td>64 MB</td>
</tr>
</tbody>
</table>
Page Description Language (PDL)/Emulation, Operating System, and Interface

<table>
<thead>
<tr>
<th>PDL/Emulations</th>
<th>Windows only</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interfaces</td>
<td>Standard local: USB</td>
</tr>
</tbody>
</table>

MIB Compatibility

A Management Information Base (MIB) is a database containing information about network devices (such as adapters, bridges, routers, or computers). This information helps network administrators manage the network (analyze performance, traffic, errors, and so on). Dell Color Laser Printer 1320c complies with standard industry MIB specifications, allowing the printer to be recognized and managed by various printer and network management software systems, such as IBM Tivoli, Hewlett-Packard OpenView, CA Unicenter, Hewlett-Packard Web JetAdmin, and so on.

Environmental

Operation

<table>
<thead>
<tr>
<th>Temperature</th>
<th>5-32°C</th>
</tr>
</thead>
<tbody>
<tr>
<td>Relative humidity</td>
<td>15-85% RH (no condensation)</td>
</tr>
</tbody>
</table>

Print Quality Guarantee

<table>
<thead>
<tr>
<th>Temperature</th>
<th>15-28°C</th>
</tr>
</thead>
<tbody>
<tr>
<td>Relative humidity</td>
<td>20-70% RH (no condensation)</td>
</tr>
</tbody>
</table>

Storage

<table>
<thead>
<tr>
<th>Temperature range</th>
<th>0-35°C (32-95 °F)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Storage humidity range</td>
<td>15-80% RH (no condensation)</td>
</tr>
</tbody>
</table>

Altitude

<table>
<thead>
<tr>
<th>Operating</th>
<th>Up to 3,100 m (10,000 feet)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Storage</td>
<td>70.9275 Kpa</td>
</tr>
</tbody>
</table>

Cables

Your interconnection cable must meet the following requirements:

<table>
<thead>
<tr>
<th>Connection type</th>
<th>Connection specifications and symbols</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Ethernet</td>
<td>10 Base-T/100 Base-TX</td>
</tr>
<tr>
<td>2 USB</td>
<td>USB2.0</td>
</tr>
</tbody>
</table>
Safety and Regulatory Information

Safety Information

⚠️ CAUTION: Read and follow all safety instructions in your Product Information Guide prior to setting up and operating your printer.

Regulatory Notices

Electromagnetic Interference (EMI) is any signal or emission, radiated in free space or conducted along power or signal leads, that endangers the functioning of a radio navigation or other safety service or seriously degrades, obstructs, or repeatedly interrupts a licensed radio communications service. Radio communications services include but are not limited to AM/FM commercial broadcast, television, cellular services, radar, air-traffic control, pager, and Personal Communication Services (PCS). These licensed services, along with unintentional radiators such as digital devices, including computer systems, contribute to the electromagnetic environment.

Electromagnetic Compatibility (EMC) is the ability of items of electronic equipment to function properly together in the electronic environment. While this computer has been designed and determined to be compliant with regulatory agency limits for EMI, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause interference with radio communications services, which can be determined by turning the equipment off and on, you are encouraged to try to correct the interference by one or more of the following measures:

- Reorient the receiving antenna.
- Relocate the computer with respect to the receiver.
- Move the computer away from the receiver.
- Plug the computer into a different outlet so that the computer and the receiver are on different branch circuits.

If necessary, consult a Dell Support representative or an experienced radio/television technician for additional suggestions.

For additional regulatory information, see the product information guide or user's guide for your computer.

Dell™ products are designed, tested, and classified for their intended electromagnetic environment. These electromagnetic environment classifications generally refer to the following harmonized definitions:

- Class A is typically for business or industrial environments. Class B products may also be utilized in a Class A environment.
- Class B is typically for residential environments. Class A products should not be utilized in a Class B environment.

Information Technology Equipment (ITE), including peripherals, expansion cards, printers, input/output (I/O) devices, monitors, and so on, that are integrated into or connected to the computer should match the electromagnetic environment classification of the computer.
A Notice About Shielded Signal Cables: Use only shielded cables for connecting devices to any Dell device to reduce the possibility of interference with radio communications services. Using shielded cables ensures that you maintain the appropriate Electromagnetic Compatibility classification for the intended environment. For parallel printers, a cable is available from Dell. If you prefer, you can order a cable from Dell on the World Wide Web at www.dell.com.

Dell has determined that this product is a Class B harmonized product. The following sections provide country-specific EMC/EMI or product safety information.

FCC Notice (U.S. Only)

FCC Class B

This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the manufacturer's instruction manual, may cause interference with radio and television reception. This equipment has been tested and found to comply with the limits for a Class B digital device pursuant to Part 15 of the FCC Rules.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions:

1. This device may not cause harmful interference.
2. This device must accept any interference received, including interference that may cause undesired operation.

 NOTICE: The FCC regulations provide that changes or modifications not expressly approved by Dell Inc. could void your authority to operate this equipment.

These limits are designed to provide reasonable protection against harmful interference in a residential installation. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference with radio or television reception, which can be determined by turning the equipment off and on, you are encouraged to try to correct the interference by one or more of the following measures:

- Reorient the receiving antenna.
- Relocate the system with respect to the receiver.
- Move the system away from the receiver.
- Plug the system into a different outlet so that the system and the receiver are on different branch circuits.

If necessary, consult a representative of Dell Inc. or an experienced radio/television technician for additional suggestions.

The following information is provided on the device or devices covered in this document in compliance with the FCC regulations:

- Product name: Dell™ Color Laser Printer
- Model number: 1320c
- Company name:
  Dell Inc.
  Worldwide Regulatory Compliance & Environmental Affairs
  One Dell Way
  Round Rock, TX 78682 USA
  512-338-4400

 NOTE: For Further regulatory information, see your Product Information Guide.

CE Notice (European Union)

This product has been determined to be in compliance with 73/23/EEC (Low Voltage Directive), 89/336/EEC (EMC Directive), and amendments of the European Union.

European Union, Class B

This Dell device is classified for use in a typical Class B domestic environment.
A "Declaration of Conformity" in accordance with the preceding directives and standards has been made and is on file at Dell Inc. Products Europe BV, Limerick, Ireland.

Předpisy CE (Evropská unie)


Evropská unie, třída B

Toto vybavení splňuje požadavky EU pro použití v období průměrné domácnosti (třída B). Toto vybavení je určeno pro použití v období průměrné domácnosti (třída B).

Evropská unie, třída A

Toto vybavení je určeno pro použití v období průměrné domácnosti (třída A). Toto vybavení je určeno pro použití v období průměrné domácnosti (třída A).

CE-konformité (Evropské Unie)

Toto zařízení splňuje požadavky na výrobky, které vyhovují normám 73/23/EEC (Elektromagnetická kompatibility), 89/336/EEC (normy EMC) a směrnici Evropské unie č. 1999/5/EC.

EU-union (Klasa B)

Toto zařízení je určeno pro použití v období průměrné domácnosti (třída B). Toto zařízení je určeno pro použití v období průměrné domácnosti (třída B).

Nordisk CE-geværelse (Evropske Unie)

Toto zařízení splňuje požadavky na výrobky, které vyhovují normám 73/23/EEC (Elektromagnetická kompatibility), 89/336/EEC (normy EMC) a směrnici Evropské unie č. 1999/5/EC.

CE-klass (Klasa B)

Toto zařízení je určeno pro použití v období průměrné domácnosti (třída B). Toto zařízení je určeno pro použití v období průměrné domácnosti (třída B).

Reglementation CE (Unie europeens)


Union europeens, classe B

Ce produit est conforme aux directives de la faible tension (class B). Ce produit est conforme aux directives de la faible tension (class B).

CE-Hinweis (Europäische Union)


Europäische Union, Klasse B


Σήμα CE (Ευρωπαϊκή Ένωση)

Αυτό το προϊόν ακολουθεί τις ευρωπαϊκές απαιτήσεις με την Οδηγία 73/23/ΕΟΚ (μείωση της πίεσης), 89/336/ΕΟΚ (ψηφιοδοτημένης παραγωγής) και 93/68/ΕΟΚ (Ευρωπαϊκής Οικονομίας).
CE jedná (Europos Sąjunga)

 Ninijų produkto gaminimas siekia konformiškumą su Europos Sąjungos Direktiva su darbuotojais ir elektroninėmis komponentomis. Taip, šioje technologijoje naudojama, ir nenustatytas konfliktas su mūsų klientų parinkimais. Dėl to šis įrenginys gali būti naudojamas tik ieskotuose interneto šaltiniuose ir televizijoje. 

 Avviso CE (Unione Europea)

 L'elettricità è un risorsa che dobbiamo valorizzare. Questo prodotto è stato progettato e realizzato in conformità con le direttive 73/23/CEE (Direttiva sulle macchine), 93/68/CEE (Direttiva sulle macchine), 2004/108/CEE (Direttiva sulle macchine), 89/336/CEE (Direttiva sulle macchine), 93/68/CEE (Direttiva sulle macchine) e 2004/108/CEE (Direttiva sulle macchine) e le direttive precise e state di legge, in particolare la direttiva 600/2002. 

 CE znamka (Evropska unija)

 Ta to izdele je izdelani v skladu z Direktivo za varnost in elektronske komponente, 73/23/EEC (Direktiva za strojevne napetosti), 93/68/EEC (Direktiva za strojevne napetosti) in Evropsko Sajmujo v vsekinih dokumentih, ki jih potrebujejo. 

 Europska Sajma, klasa B

 Ši įrenginio playstation laikina maksimalius kodžių lyginius nei normą (B klasės) apskatina. 

 Avviso CE (Unione Europea)

 L'eletricità è un risorse che dobbiamo valorizzare. Questo prodotto è stato progettato e realizzato in conformità con le direttive 73/23/CEE (Direttiva sulle macchine), 93/68/CEE (Direttiva sulle macchine), 2004/108/CEE (Direttiva sulle macchine), 89/336/CEE (Direttiva sulle macchine) e le direttive precise e state di legge, in particolare la direttiva 600/2002. 

 CE poznamka (Evropska unija)

 To je izdele izdelani v skladu z Direktivo za varnost in elektronske komponente, 73/23/EEC (Direktiva za strojevne napetosti), 93/68/EEC (Direktiva za strojevne napetosti), 2004/108/EEC (Direktiva za strojevne napetosti) in Evropsko Sajmujo v vsekinih dokumentih, ki jih potrebujejo. 

 Avviso CE (Unione Europea)

 L'eletricità è un risorsa che dobbiamo valorizzare. Questo prodotto è stato progettato e realizzato in conformità con le direttive 73/23/CEE (Direttiva sulle macchine), 93/68/CEE (Direttiva sulle macchine), 2004/108/CEE (Direttiva sulle macchine), 89/336/CEE (Direttiva sulle macchine) e le direttive precise e state di legge, in particolare la direttiva 600/2002. 

 CE znamka (Evropska unija)

 Ta to izdele je izdelani v skladu z Direktivo za varnost in elektronske komponente, 73/23/EEC (Direktiva za strojevne napetosti), 93/68/EEC (Direktiva za strojevne napetosti) in Evropsko Sajmujo v vsekinih dokumentih, ki jih potrebujejo. 

 Avviso CE (Unione Europea)

 L'eletricità è un risorsa che dobbiamo valorizzare. Questo prodotto è stato progettato e realizzato in conformità con le direttive 73/23/CEE (Direktiva sulle macchine), 93/68/CEE (Direktiva sulle macchine), 2004/108/CEE (Direktiva sulle macchine), 89/336/CEE (Direttiva sulle macchine) e le direttive precise e state di legge, in particolare la direttiva 600/2002. 

 CE poznamka (Evropska unija)

 To je izdele izdelani v skladu z Direktivo za varnost in elektronske komponente, 73/23/EEC (Direktiva za strojevne napetosti), 93/68/EEC (Direktiva za strojevne napetosti), 2004/108/EEC (Direktiva za strojevne napetosti) in Evropsko Sajmujo v vsekinih dokumentih, ki jih potrebujejo. 

 Avviso CE (Unione Europea)

 L'eletricità è un risorsa che dobbiamo valorizzare. Questo prodotto è stato progettato e realizzato in conformità con le direttive 73/23/CEE (Direktiva sulle macchine), 93/68/CEE (Direktiva sulle macchine), 2004/108/CEE (Direktiva sulle macchine), 89/336/CEE (Direttiva sulle macchine) e le direttive precise e state di legge, in particolare la direttiva 600/2002. 

 CE znamka (Evropska unija)

 Ta to izdele je izdelani v skladu z Direktivo za varnost in elektronske komponente, 73/23/EEC (Direktiva za strojevne napetosti), 93/68/EEC (Direktiva za strojevne napetosti) in Evropsko Sajmujo v vsekinih dokumentih, ki jih potrebujejo. 

 Avviso CE (Unione Europea)

 L'eletricità è un risorsa che dobbiamo valorizzare. Questo prodotto è stato progettato e realizzato in conformità con le direttive 73/23/CEE (Direktiva sulle macchine), 93/68/CEE (Direktiva sulle macchine), 2004/108/CEE (Direktiva sulle macchine), 89/336/CEE (Direttiva sulle macchine) e le direttive precise e state di legge, in particolare la direttiva 600/2002. 

 CE poznamka (Evropska unija)

 To je izdele izdelani v skladu z Direktivo za varnost in elektronske komponente, 73/23/EEC (Direktiva za strojevne napetosti), 93/68/EEC (Direktiva za strojevne napetosti), 2004/108/EEC (Direktiva za strojevne napetosti) in Evropsko Sajmujo v vsekinih dokumentih, ki jih potrebujejo. 

 Avviso CE (Unione Europea)

 L'eletricità è un risorsa che dobbiamo valorizzare. Questo prodotto è stato progettato e realizzato in conformità con le direttive 73/23/CEE (Direktiva sulle macchine), 93/68/CEE (Direktiva sulle macchine), 2004/108/CEE (Direktiva sulle macchine), 89/336/CEE (Direttiva sulle macchine) e le direttive precise e state di legge, in particolare la direttiva 600/2002. 

 CE znamka (Evropska unija)

 Ta to izdele je izdelani v skladu z Direktivo za varnost in elektronske komponente, 73/23/EEC (Direktiva za strojevne napetosti), 93/68/EEC (Direktiva za strojevne napetosti) in Evropsko Sajmujo v vsekinih dokumentih, ki jih potrebujejo. 

 Avviso CE (Unione Europea)

 L'eletricità è un risorsa che dobbiamo valorizzare. Questo prodotto è stato progettato e realizzato in conformità con le direttive 73/23/CEE (Direktiva sulle macchine), 93/68/CEE (Direktiva sulle macchine), 2004/108/CEE (Direktiva sulle macchine), 89/336/CEE (Direttiva sulle macchine) e le direttive precise e state di legge, in particolare la direttiva 600/2002. 

 CE poznamka (Evropska unija)

 To je izdele izdelani v skladu z Direktivo za varnost in elektronske komponente, 73/23/EEC (Direktiva za strojevne napetosti), 93/68/EEC (Direktiva za strojevne napetosti), 2004/108/EEC (Direktiva za strojevne napetosti) in Evropsko Sajmujo v vsekinih dokumentih, ki jih potrebujejo. 

 Avviso CE (Unione Europea)

 L'eletricità è un risorsa che dobbiamo valorizzare. Questo prodotto è stato progettato e realizzato in conformità con le direttive 73/23/CEE (Direktiva sulle macchine), 93/68/CEE (Direktiva sulle macchine), 2004/108/CEE (Direktiva sulle macchine), 89/336/CEE (Direttiva sulle macchine) e le direttive precise e state di legge, in particolare la direttiva 600/2002. 

 CE znamka (Evropska unija)

 Ta to izdele je izdelani v skladu z Direktivo za varnost in elektronske komponente, 73/23/EEC (Direktiva za strojevne napetosti), 93/68/EEC (Direktiva za strojevne napetosti) in Evropsko Sajmujo v vsekinih dokumentih, ki jih potrebujejo. 

 Avviso CE (Unione Europea)

 L'eletricità è un risorsa che dobbiamo valorizzare. Questo prodotto è stato progettato e realizzato in conformità con le direttive 73/23/CEE (Direktiva sulle macchine), 93/68/CEE (Direktiva sulle macchine), 2004/108/CEE (Direktiva sulle macchine), 89/336/CEE (Direttiva sulle macchine) e le direttive precise e state di legge, in particolare la direttiva 600/2002.
CE Mark Notice

This equipment complies with the essential requirements of the European Union Directive 1999/5/EC.
La información siguiente se proporciona en el dispositivo o dispositivos descritos en este documento, en cumplimiento con los requisitos de la Norma oficial mexicana (NOM):

<table>
<thead>
<tr>
<th>Exportador</th>
<th>Dell Inc.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>One Dell Way</td>
</tr>
<tr>
<td></td>
<td>Round Rock, TX 78682</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Importador</th>
<th>Dell México S.A. de C.V.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Paseo de la Reforma 2620 - 11º Piso</td>
</tr>
<tr>
<td></td>
<td>Col. Lomas Altas</td>
</tr>
<tr>
<td></td>
<td>11950 México, D.F.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Enviar a:</th>
<th>Dell México S.A. de C.V.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>al Cuidado de Kuehne &amp; Nagel de México S. de R.L.</td>
</tr>
<tr>
<td></td>
<td>Avenida Soles No. 55</td>
</tr>
<tr>
<td></td>
<td>Col. Peñón de los Baños</td>
</tr>
<tr>
<td></td>
<td>15520 México, D.F.</td>
</tr>
</tbody>
</table>

### Noise Emissions Levels

The following measurements were made in accordance with ISO 7779 and reported in conformance with ISO 9296.

<table>
<thead>
<tr>
<th>State</th>
<th>Sound power level</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printing</td>
<td>6.4B, 51.6dB(A)</td>
</tr>
<tr>
<td>Idling</td>
<td>4B, 22.9dB(A)</td>
</tr>
</tbody>
</table>

### Laser Notice

The printer is certified in the U.S. to conform to the requirements of 21CFR, Chapter 1, Subchapter J for Class I (1) laser products, and elsewhere is certified as a Class 1 laser product conforming to the requirements of IEC 60825-1.

Class I laser products are not considered to be hazardous. The printer contains internally a Class IIIb (3b) laser that is nominally a 5 milliwatt gallium arsenide laser operating in the wavelength region of 770-795 nanometers. The laser system and printer are designed so there is never any human access to laser radiation above a Class I level during normal operation, user maintenance, or prescribed service condition.

### Energy Star

**ENERGY STAR® Compliance**

Any Dell™ product bearing the ENERGY STAR emblem on the product or on a start-up screen is certified to comply with Environmental Protection Agency (EPA) ENERGY STAR requirements as configured when shipped by Dell.

**ENERGY STAR® Emblem**
The EPA’s ENERGY STAR program is a joint effort between the EPA and manufacturers to reduce air pollution by promoting energy-efficient products.

You can help reduce electricity usage and its side effects by turning off your product when it is not in use for extended periods of time, particularly at night and on weekends.

**Perchlorate Material**

Perchlorate Material - special handling may apply.

See [www.dtsc.ca.gov/hazardouswaste/perchlorate](http://www.dtsc.ca.gov/hazardouswaste/perchlorate).

**MSDS Materials for Dell Printer**

All MSDS materials for Dell Printers can be found at the following URL: [http://www1.us.dell.com/content/topics/global.aspx/corp/environment/en/prod_design?c=us&l=en&s=corp&~section=001](http://www1.us.dell.com/content/topics/global.aspx/corp/environment/en/prod_design?c=us&l=en&s=corp&~section=001)

back to contents page
Appendix

Dell Technical Support Policy

Technician-assisted technical support requires the cooperation and participation of the customer in the troubleshooting process and provides for restoration of the operating system, software program and hardware drivers to the original default configuration as shipped from Dell, as well as the verification of appropriate functionality of the printer and all Dell-installed hardware. In addition to this technician assisted technical support, online technical support is available at Dell Support. Additional technical support options may be available for purchase.

Dell provides limited technical support for the printer and any Dell-installed software and peripherals. Support for third-party software and peripherals is provided by the original manufacturer, including those purchased and/or installed through Software & Peripherals (DellWare), ReadyWare, and Custom Factory Integration (CFI/DellPlus).

Online Services

You can access Dell Support at support.dell.com. Select your region on the WELCOME TO DELL SUPPORT page, and fill in the requested details to access help tools and information.

You can contact Dell electronically using the following addresses:

- World Wide Web
  - www.dell.com/
  - www.dell.com/ap/ (Asian/Pacific countries only)
  - www.dell.com/jp (Japan only)
  - www.euro.dell.com (Europe only)
  - www.dell.com/lp/ (Latin American and Caribbean countries)
  - www.dell.ca (Canada only)

- Anonymous file transfer protocol (FTP)
  - ftp.dell.com/
  - Log in as user: anonymous, and use your e-mail address as your password.

- Electronic Support Service
  - mobile_support@us.dell.com
  - support@us.dell.com
  - la-techsupport@dell.com (Latin America and Caribbean countries only)
  - apsupport@dell.com (Asian/Pacific countries only)
  - support.jp.dell.com (Japan only)
  - support.euro.dell.com (Europe only)

- Electronic Quote Service
  - apmarketing@dell.com (Asian/Pacific countries only)
Warranty and Return Policy

Dell Computer Corporation ("Dell") manufactures its hardware products from parts and components that are new or equivalent to new in accordance with industry-standard practices. For information about the Dell warranty for your printer, see the Product Information Guide.

Recycling Information

Dell recommends that customers dispose of their used computer hardware, monitors, printers, and other peripherals in an environmentally sound manner. Potential methods include reuse of parts or whole products and recycling of products, components, and/or materials.

For specific information on Dell's worldwide recycling programs, see www.dell.com/recyclingworldwide.

Waste Electrical and Electronic Equipment (WEEE) Directive

In the European Union, this label indicates that this product should not be disposed of with household waste. It should be deposited at an appropriate facility to enable recovery and recycling. For information on how to recycle this product responsibly in your country, please visit: www.euro.dell.com/recycling.
Contacting Dell™

For customers in the United States, call 800-WWW-Dell (800-999-3355).

NOTE: If you do not have an active Internet connection, you can find contact information on your purchase invoice, packing slip, bill, or in your Dell™ catalog.

Dell™ provides several online and telephone-based support and service options. Availability varies by country and product, and some services may not be available in your area. To contact Dell™ for sales, technical support, or customer service issues:

2. Verify your country or region in the Choose A Country/Region drop-down menu at the bottom of the page.
3. Click Contact Us on the left side of the page.
4. Select the appropriate service or support link based on your need.
5. Choose the method of contacting Dell™ that is convenient for you.

back to contents page
Installing Printer Drivers

Personal Printer Setup

1. Insert the Drivers and Utilities CD into your computer to start Easy Setup Navigator.

NOTE: If the CD does not automatically launch, click Start→Run, and then type D:\setup_assist.exe (where D is the drive letter of your CD), and then click OK.

2. Press Software Installation to launch the installation software.

3. Select Personal Installation, and then click Next.

4. Click Install.

5. Follow the instructions that appear on the Found New Hardware Wizard dialog box to install the printer driver on your computer.

6. When the Completing the Found New Hardware Wizard dialog box appears, click Finish.

7. Select either Typical Installation or Custom Installation from the installation wizard, and then click Install. If you select Custom Installation, you can select the specific software you want to install.

8. Click Finish to exit the wizard when the Congratulations! screen appears. To print a test page, click Print Test Page to print a test page.

USB Printing

A local printer is a printer attached to your computer or a print server using a USB. If your printer is attached to a network and not your computer, see "Network Printer Setup" on page 163.

Network Printer Setup

Printing and Checking the System Settings Page

Before installing the printer driver on your computer, print the System Settings page to check your printer's IP address.

1. Print the Printer Settings page.
   a. Click Start→All Programs→Dell Printers→Additional Color Laser Software→Status Monitor Console.
      The Printer Selection dialog box opens.
   b. Click Dell Color Laser 1320c listed in Printer Name.
      The Dell Color Laser 1320c Launcher window opens.
   c. Click the Tool Box button.
      The Tool Box opens.
      You can also launch the Tool Box from the printer icon on the taskbar.
   d. Click the Printer Settings Report tab.
   e. Select Reports from the list at the left side of the page.
      The Reports page is displayed.
   f. Click the Start button for Printer Settings.
      The printer settings page is printed.

2. Verify the IP address.
   a. Click Start→All Programs→Dell Printers→Additional Color Laser Software→Status Monitor Console.
      The Printer Selection dialog box opens.
   b. Click Dell Color Laser 1320c listed in Printer Name.
      The Dell Color Laser 1320c Launcher window opens.
   c. Click the Tool Box button.
      The Tool Box opens.
      You can also launch the Tool Box from the printer icon on the taskbar.
   d. Click the Printer Settings Report tab.
Select TCP/IP Settings from the list at the left side of the page. If the IP address is 0.0.0.0, wait for a few minutes to resolve the IP address automatically, and then display the TCP/IP Settings page again.

You can also print and check the printer settings from the Report page. To print the Report page, press and hold the Continue button on the operator panel.

**Disable Microsoft® Windows® XP, Windows Vista®, Windows Server® 2003 (after SP1) , or Windows Server 2008 Firewall Before Printer Software Installation**

*NOTE:* This step may not be necessary if you have Windows XP Service Pack 2 installed.

If your printer is connected directly to a network and the Windows XP, Windows Vista, Windows Server 2003 (after SP1), or Windows Server 2008 firewall is enabled, you cannot view your networked printer(s) when you run the Dell™ printer installation software. To prevent this situation, disable the firewall before you install the Dell printer software. To disable or enable the firewall, perform the following steps.

1. Click the Start button and click Help and Support.
2. In the Search box, type firewall and then press Enter.

In the list, click Turn Windows Firewall on or off and then follow the instructions on the screen.

**Local Printer Setup**

1. Insert the Drivers and Utilities CD into your computer to start Easy Setup Navigator.

*NOTE:* If the CD does not automatically launch, click Start -> Run, and then type D:\setup_assist.exe (where D is the drive letter of your CD), and then click OK.

2. Press Software Installation to launch the installation software.
3. Select Network Installation, and then click Next.
4. Select Local Installation, and then click Next.
5. Select the printer you want to install from the printer list, and then click Next. If the target printer is not displayed on the list, click Refresh to refresh the list or click Add Printer to add a printer to the list manually. You may specify the IP address and port name at this point. If you have installed this printer on the server computer, select the I am setting up this printer on a server check box.

*NOTE:* When using AutoIP, 0.0.0.0 is displayed in the installer. Before you can continue, you must enter a valid IP address.

6. Specify the printer settings, and then click Next.
   a. Enter the printer name.
   b. If you want other users on the network to access this printer, select Share this printer with other computers on the network, and then enter a share name that users will easily identify.
   c. If you want to set a printer as the default, select the Set this printer as default check box.
   d. If you want to restrict color printing, select the appropriate Dell ColorTrack option. Enter the password when Color-Password Enabled is selected for Dell ColorTrack.

7. Select the software and documentation you want to install, and then click Next. You can specify folders in which to install the Dell software and documentation. To change the folders, click Browse.
8. Click Finish to exit the wizard when the Congratulations! screen appears. If necessary, click Print Test Page to print a test page.

**Enable Network Discovery and File Sharing for all Public Networks**

You can skip "Disable User Account Control" for this procedure.

*NOTE:* This step is required when you use Windows Vista or Windows Server 2008 for the server computer.

1. Click Start -> Network.
2. Click Network discovery and file sharing are turned off. Network computers and devices are not visible. Click to change.
3. Click Turn on network discovery and file sharing.
4. Click Yes, turn on network discovery and file sharing for all public networks.

**Remote Printer Setup**

**Before Installation**
Before you start remote installation, perform the following procedures.

**Allow Print Spooler to Accept Client Connections**


1. Click **Start** ➔ **Run.**
   - For Windows Server 2003/Windows Server 2008: Click **Start** ➔ **Run.**
   - For Windows Vista: Click **Start** ➔ **All Programs** ➔ **Accessories** ➔ **Run.**

2. Type `gpedit.msc`, and then click **OK.**

3. Click **Continue.** *(for Windows Vista only)*

4. Click **Computer Configuration** ➔ **Administrative Templates** ➔ **Printers.**

5. Right-click **Allow Print Spooler to accept client connections** and select **Properties.**

6. From the **Setting** tab, select **Enabled**, and then click **OK.**

7. Restart the computer.

**Share the Firewall File and Printer**


**For Windows Vista:**

1. Click **Start** ➔ **Control Panel.**

2. Select **Security.**

3. Click **Windows Firewall.**

4. Click **Change settings.**

5. Click **Continue.**

6. From the **Exceptions** tab, check the **File and Printer Sharing** check box, and then click **OK.**

**For Windows XP:**

1. Click **Start** ➔ **Control Panel.**

2. Select **Security Center.**

3. Click **Windows Firewall.**

4. From the **Exceptions** tab, check the **File and Printer Sharing** check box, and then click **OK.**

**For Windows Server 2008:**

1. Click **Start** ➔ **Control Panel.**

2. Double-click **Windows Firewall.**

3. Click **Change settings.**

4. From the **Exceptions** tab, check the **File and Printer Sharing** check box, and then click **OK.**

**Start Remote Registry**

- **NOTE:** This step is required for Windows Vista or Windows Server 2008.

**For Windows Vista:**

1. Click **Start** ➔ **Control Panel.**

2. Select **System and Maintenance.**

3. Click **Administrative Tools.**

4. Double-click **Services.**

5. Click **Continue.**

6. Right-click **Remote Registry** and select **Start.**

7. Right-click **Remote Registry** and select **Properties.**

8. Change **Startup type:** to **Automatic**, and then click **OK.**

**For Windows Server 2008:**
1. Click Start → Administrative Tools.
2. Click Services.
3. Right-click Remote Registry and select Start.
4. Right-click Remote Registry and select Properties.
5. Change Startup type: to Automatic, and then click OK.

**Disable User Account Control**

*NOTE:* This step is required for Windows Vista or Windows Server 2008.

**For Windows Vista:**

1. Click Start → Control Panel.
3. Click User Accounts.
4. Click Turn User Account Control on or off.
5. Click Continue.
6. Clear the Use User Account Control (UAC) to help protect your computer check box.
7. Restart the computer.

**For Windows Server 2008:**

1. Click Start → Control Panel.
2. Double-click User Accounts.
3. Click Turn User Account Control on or off.
4. Clear the Use User Account Control (UAC) to help protect your computer check box.
5. Click OK.
6. Restart the computer.

**Enable Network Discovery and File Sharing for all Public Networks**

You can skip "Disable User Account Control" for this procedure.

*NOTE:* This step is required when you use Windows Vista or Windows Server 2008 for the server computer.

1. Click Start → Network.
2. Click Network discovery and file sharing are turned off. Network computers and devices are not visible. Click to change.
3. Click Turn on network discovery and file sharing.
4. Click Yes, turn on network discovery and file sharing for all public networks.

**Disable Simple File Sharing**


1. Click Start → Control Panel.
2. Select Appearance and Themes.
3. Select Folder Options.
4. From the View tab, clear the Use simple file sharing(Recommended) check box, and then click OK.
5. Click Start → Control Panel.
7. Select Administrative Tools.
8. Click Local Security Policy.
9. Click Local Policies → Security Options.
10. Right-click Network access: Sharing and security model for local accounts and select Properties.
11. Ensure Classic - local users authenticate as themselves is selected.

**Installing the Printer Driver**
1. Insert the Drivers and Utilities CD into your computer to start Easy Setup Navigator.

   **NOTE:** If the CD does not automatically launch, click Start – Run, and then type D:\setup_assist.exe (where D is the drive letter of your CD), and then click OK.

2. Press Software Installation to launch the installation software.

3. Select Network Installation, and then click Next.

4. Select Remote Installation, and then click Next.

   **NOTE:** Installation on Windows XP Home Edition/Vista Home Basic/Vista Home Premium is not supported.

5. Enter the computer name, user ID, and password. Then, click Add.

6. Click Next.

7. Select the printer you want to install from the printer list, and then click Next. If the target printer is not displayed on the list, click Refresh to refresh the list or click Add Printer to add a printer to the list manually. You may specify the IP address and port name at this point.

8. Specify the printer settings, and then click Next.

   a. Enter the printer name.

   b. If you want other users on the network to access this printer, select Share this printer with other computers on the network, and then enter a share name that users will easily identify.

   c. If you want to set a printer as the default, select the Set this printer as default check box.

   d. If you want to restrict color printing, select the appropriate Dell ColorTrack option. Enter the password when Color-Password Enabled is selected for Dell ColorTrack.

9. Select the software and documentation you want to install, and then click Next. You can specify folders in which to install the Dell software and documentation. To change the folders, click Input.

10. Click Finish to exit the wizard when the Congratulations! screen appears.

Use the Dell Printer Configuration Web Tool to monitor the status of your network printer without leaving your desk. You can view and/or change the printer configuration settings, monitor toner level, and when it is time to order replacement consumables, just click the Dell supplies link right from your Web browser.

   **NOTE:** The Dell Printer Configuration Web Tool is not available when the printer is locally attached to a computer or a print server.

To launch the Dell Printer Configuration Web Tool, type the network printer IP address in your Web browser, and the printer configuration appears on the screen.

You can set up the Dell Printer Configuration Web Tool to send you an email when the printer needs supplies or intervention.

To set up e-mail alerts:

1. Launch the Dell Printer Configuration Web Tool.
2. Click E-Mail Alert link.
3. Under Setup E-Mail Lists and Alerts, enter the Primary SMTP Gateway, the Reply Address, and enter your email address or the key operator's email address in the email list box.
4. Click Apply New Settings.

   **NOTE:** The SMTP server will display Connection in Progress until an error occurs.

**Setup Security**

2. Click Dell Color Laser 1320c listed in Printer Name. The Dell Color Laser 1320c Launcher window opens.
3. Click the Tool Box button. The Tool Box opens. You can also launch the Tool Box from the printer icon on the taskbar.
4. Click the Printer Maintenance tab.
5. Select Set Password from the list at the left side of the page. The Set Password page is displayed. To set or change the password to limit access to the Tool Box menus, set the password of the Dell Printer Configuration Web Tool from Set Password in Other Features.
**Troubleshooting Instructions**

Use the Customer Mode to locate the unit in the printer that causes a problem.

**Checking the printer operations**

1. Click **Start** → **All Programs** → **Dell Printers** → **Additional Color Laser Software** → **Status Monitor Console.**
   The Printer Selection dialog box opens.
2. Click **Dell Color Laser 1320c** listed in Printer Name.
   The Dell Color Laser 1320c Launcher window opens.
3. Click the **Tool Box** button.
   The Tool Box opens.
   You can also launch the Tool Box from the printer icon on the taskbar,
4. Click the **Diagnosis** tab.
5. Select Machine Check from the list at the left side of the page.
   The Machine Check page is displayed.
6. Click the **Start** button after selecting the desired item.
   The selected page is printed.

**Clear NVRAM**

You can restore the original factory default menu settings by initializing NVRAM.

1. Click **Start** → **All Programs** → **Dell Printers** → **Additional Color Laser Software** → **Status Monitor Console.**
   The Printer Selection dialog box opens.
2. Click **Dell Color Laser 1320c** listed in Printer Name.
   The Dell Color Laser 1320c Launcher window opens.
3. Click the **Tool Box** button.
   The Tool Box opens.
   You can also launch the Tool Box from the printer icon on the taskbar,
4. Click the **Printer Maintenance** tab.
5. Select **Reset Defaults** from the list at the left side of the page.
   The Reset Defaults page is displayed.
6. Click **Start** to initialize the non-volatile memory (NVM) memory.
   The printer is turned off automatically to apply the settings.